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OZET

Yiiksek Lisans Tezi
Elektronik Devreler i¢in Artirilmis Gergeklik Tabanli Platform Gelistirilmesi
Sanaa IRIQAT
Bursa Uludag Universitesi
Fen Bilimleri Enstitiisii
Elektronik Miihendisligi Anabilim Dali
Danmisman: Prof. Dr. Fahri VATANSEVER

Miihendislik bilimi, uygulanabilir perspektifi nedeniyle diger bilimlerden farklidir. Bir miihendis i¢in en
onemli sey sadece teorik kavramlari anlamak degil, ayn1 zamanda bu teorik bilgiyi ger¢ek hayatta
uygulama becerisine sahip olmaktir. Miihendislik egitimindeki teorik bilgilerin, daha iyi anlasilmasi,
kavranabilmesi ve pekistirilebilmesi i¢cin mutlaka pratik uygulamalarla desteklenmesi gerekmektedir. Bu
da egitim ortamlarindaki laboratuvar uygulamalariyla miimkiin olmaktadir. Ancak yeterli altyapi ve
donanimlarin olmamasi, dgrenci sayilarmin fazlaligi gibi nedenlerden dolay:1 laboratuvar kisimlarinda
sikintilar yaganabilmektedir. Bu nedenle - uygulama kisimlarinda - alternatif arayislara gidilmektedir.

Teknolojideki hizli gelismeler, her alanda kendini gostermektedir. Ozellikle bilgisayar diinyasindaki
ilerlemeler sonucunda "bilgisayar destekli miihendislik", "bilgisayar destekli tasarim", "bilgisayar destekli
egitim" gibi kavramlar siklikla kullanilmaktadir. Bunun yaninda "artirilmis gergeklik", "sanal gergeklik",
"karma gerceklik" gibi gerceklik tiirleri ve bunlarla iliskili, bir¢ok alanda kullanilan gerceklik
uygulamalari gelistirilmistir.

Bu tezde, elektronik devreler alanindaki temel yapilardan olan islemsel yiikseltecler igin artirilmig
gerceklik tabanl bir platform gelistirilmistir. Sadece akilli telefon ve breadboard gereken bu platformda
temel islemsel yiikseltegli devre yapilarindan olan eviren-evirmeyen yiikselteg, toplama-fark, integral-
tirev devresi gibi uygulamalar - zengin gorsel destekli (giris-gikis isaretleri, kullanici tamimli devre
elemanlari, bunlarin baglantilari, breadboard {izerindeki yerlesimleri vb.) olarak - hizli ve kolay sekilde
yapilabilmektedir. Prensip olarak akilli telefon, elektronik devre isaretleyicisinin bir resmini ¢cekmekte ve
dijital olarak orijinal goriintli ile karistirilmig bir sanal nesneler katmani olusturmaktadir. Gelistirilen
artirilmig gergeklik platformu; etkilesimli olarak devre elemanlarini belirlemeyi, devre kurmay1, devrenin
breadboard iizerindeki yerlesimini, devre bagmntilarim ve grafiksel olarak girig-¢ikis isaretlerini
gostermektedir. Boylece tasarlanan platform; artirilmis gergekligi, etkilesimli bir kullanici kilavuzu olarak
sunmakta, 6grencilere veya bu alanda ¢alisan kisilere islemsel yiikseltecgli devrelerin analiz ve sentezi igin
rehberlik etmekte, zengin gorsel igerigiyle yeni ve ilging bir alternatif uygulama/6gretme yolu olarak
kullandirmaktadir.

Anahtar Kelimeler: Artirilmis gergeklik, elektronik devre, islemsel yiikselteg, egitim teknolojisi

2020, viii + 102 sayfa.



ABSTRACT

MSc Thesis
The Development of Augmented Reality Based Platform for Electronic Circuits
Sanaa IRIQAT
Bursa Uludag University
Graduate School of Natural and Applied Sciences
Department of Electronics Engineering

Supervisor: Prof. Dr. Fahri VATANSEVER

Engineering science differs from other sciences because of its applicable perspective. The most important
thing for an engineer is not only to understand theoretical concepts, but also to have the ability to apply
this theoretical knowledge in real life. In order for the theoretical knowledge in engineering education to
be better understood, grasped and reinforced, it must be supported by practical applications. This is
possible with laboratory applications in educational environments. However, there may be problems in
the laboratory parts due to reasons such as the lack of sufficient infrastructure and equipment, and the
large number of students. For these reasons, alternatives are sought in the application sections.

Rapid developments in technology show themselves in every field. Concepts such as “"computer aided
engineering", "computer aided design" and "computer aided education" are frequently used, especially as
a result of the advances in the computer world. In addition, reality types such as "augmented reality",
"virtual reality", "mixed reality" and related reality applications used in many fields have been developed.

In this thesis, an augmented reality-based platform has been developed for operational amplifiers, one of
the basic structures in the field of electronic circuits. In this platform, where only a smart phone and a
breadboard are required, applications such as inverting-non inverting amplifiers, summing-differential,
integrator-differentiator circuits, which are among the basic operational amplifier circuit structures - with
rich visual support (input-output signals, user-defined circuit elements, circuit connections, circuit
placements on the breadboard, etc.) - can be done quickly and easily. Principally, the smartphone takes a
picture of the electronic circuit marker and digitally forms a layer of virtual objects that are mixed with
the original image. Thus designed platform; presents augmented reality as an interactive user guide,
guides students or people working in this field for the analysis and synthesis of operational amplifier
circuits, and makes them use it as a new and interesting alternative application / teaching way with its rich
visual content.

Key words: Augmented reality, electronic circuits, op-amp amplifiers, educational technology

2020, viii + 102 pages.
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1. GIRIS

Teknolojideki hizli gelismeler, hayatin her alanina yansimaktadir. Bu gelismelerden birisi de
insanin gercgeklik algisin1 degistiren uygulamalardir. Artirilmis, sanal, karma gergeklik gibi
teknolojiler sayesinde gercek diinya ile sanal diinyanin entegrasyonu olusturulmakta ve
insanogluna bir¢ok yararlar sunmaktadir. Giiniimiizde bu teknolojilerin kullanimi bir¢ok alanda

(miihendislik, saglik, egitim, vb.) artmaktadir.

Artirilmis gergeklik (AG), gergeklik ve sanallik arasinda bulunan bir bilgisayar bilimi alanidir.
Artirilmig gergeklik, bilgisayar tarafindan iiretilen iic boyutlu (3B) sanal nesneleri, grafikleri,
sesleri, metinleri ve videolar1 ekleyerek ii¢ boyutlu gercek diinya ortamlarini degistirme
teknolojisidir (Azuma ve ark. 2001). Baska bir tanimla, AG dijital verilerin kullanimt ile fiziksel

diinyaya iliskin gelismis (artirilmis) bir goriiniim saglamaktir (Milgram ve ark. 1994).

AG teknolojisi son yillarda ortaya ¢ikmis ve bir¢ok alanda ¢ok yonlilliigiinii kanitlamistir.
Artirllmis gergeklik uygulamalari, askeri ve tibbi amaclardan eglence, sanat, egitim, mimari gibi

bircok disipline kadar neredeyse her alanda kullanilmaktadir (Baloch ve ark. 2018).

Modern ¢agda, insanlarin gesitli teknolojileri kabul etme ve kullanma yetenegi hem endiistriyel
hem de egitim alaninda hizli bir sekilde artmaktadir. Insanlari, ihtiya¢ duyduklar dzel bilgi ve
beceriler konusunda egitmenin birgok farkli yolu vardir. Smifta islenen dersler, ders kitaplari,
bilgisayarlar, el cihazlar1 ve diger elektronik aygitlar yaygin egitim yontemleridir. Bir kiginin
teknolojik bilgisiyle dogru orantili olarak egitimde yeniligi segme egilimi o kadar artmaktadir.
Cok fazla bilginin bulundugu hizla degisen bir toplumda, hem okulda hem de is ortamlarinda ana
yeterlilige ulagsmak i¢in dogru zamanda ve yerde bilgi benimsemeye ve uygulamaya ihtiyag
vardir. AG, egitim ve Ogretimin yerini ve zamanlamasint Onemli Olciide degistiren bir

teknolojidir (Lee 2012).

Egitim alani, 6gretim yontemini ilerletmek icin yeni egilimler uygulamaya devam etmektedir.
Modern diinyanin bugiinkii egilimlerinden birisi de 6grenme siirecini kolaylagtirmak ve onu
miimkiin oldugunca eglenceli ve kullanish hale getirmek i¢in artirilmis gergeklik uygulamalari
olusturmaktir. Ogrencilerin 6grenme ve anlama, bilgisayar tarafindan iiretilen grafiklerle etkili

etkilesimleriyle gelistirilebilir (Tuli ve Mantri 2015).



Ozellikle, miihendislik alanindaki egitim, uygulanabilir perspektifi nedeniyle diger bilimlerden
farklidir. Miihendislik 6grencilerinin  birgogunda pratik uygulama eksikligi vardir, ¢iinkii
laboratuvarlarda 6grenmek icin gereken zamani harcamamakta veya cok sayida Ogrenci
nedeniyle 6gretmenlerden yeterli destek alamamaktadirlar. Bu sorunu ¢ézmeye calisan bir¢ok
calisma vardir ve bu calismalardan en 6nemlilerinden birileri sanal ve uzak laboratuvarlardir.
Ogrenciler laboratuvarda olmaya gerek kalmadan sanal olarak veya uzaktan deneyler

yapabilmektedir (Canfora ve ark. 2004).

Miihendislik 6grencileri, teorik bilgileri diinyadaki tiim okullarda pratik kullanima uygulamakla
yikiimliidiir. Pratik beceriler, Ogrencilere yardimci olmak i¢in kullanim kilavuzlar ve
Ogretmenler tarafindan laboratuvar tesislerinde yapilan uygulamali deneylerle artirilmaktadir

(Benmohamed ve ark. 2007).

Bu tez, elektronik devrelerin Ogretilmesi icin AG tabanli bir platformun gelistirilmesi ve
otomatiklestirilmesine ~ yonelik  bir  yaklasim  sunmaktadir.  Gelistirilen  platform;
etkilesimli/interaktif bir kullanim kilavuzu olarak AG sunarak 6grencilerin elektronik devreler
olusturmalarina rehberlik etmek, bdylece Ogrencilerin ilgisini ve dikkatini artirmak ve
laboratuvar egitmenlerinin is yiikiinii azaltmak icin alternatif bir yol sunmaktadir. Onerilen
sistem, islemsel yiikselteg¢ (op—amp) devre isaretleyicilerinin otomatik olarak tanimlanmasini
saglamaktadir. Temel islemsel yiikselte¢li devreleri (eviren, evirmeyen, toplama, ¢ikarma, tiirev,
integral) tanimlamak ve uygulamalar/egitimler gerceklestirebilmek i¢in sadece bir akilli telefon
ve bir breadboard yeterlidir. Akilli telefon, elektronik devre isaretleyicisinin resmini ¢ekerek
orijinal goriintii ile karigtirilan bir sanal nesne katmanini sayisal (dijital) olarak olusturmaktadir.
Boylece etkilesimli olarak secilen devre elemani degerlerine gore elemanlarin baglantilari, devre

yapist, giris-cikis bagintilar1 ve grafiksel olarak da giris-¢ikis isaretleri goriintiilenmektedir.
Bu tez calismasinin arastirma sorular1 su sekilde 6zetlenebilmektedir:

e Miihendislik 6grencileri, egitici/0gretici rehberligi olmadan tiim deneyleri gelistirilmis
AG platformunu kullanarak gergeklestirebilir mi?
e Miihendislik Ogrencileri, gelistirilen AG platformunu kullanarak pratik becerilerini

gelistirebilir mi?



Tezin arastirma hedefleri ise

e Artirilmis gergekligi, bu alandaki gelismeleri ve teknolojileri anlamak ve kullanmak,

e AG tabanli uygulamalar gelistirebilmek,

e Islemsel yiikseltegli devreler icin AG tabanli platform tasarlamak ve gelistirmek,

e AG prototipini uzmanlar araciligiyla degerlendirmek ve gelistirmek,

e Ogrencilerin, anlamalarim artirmak i¢in deneyler yaparak laboratuvarda etkili bir sekilde
etkilesime girmelerine yardimcei olmak,

e Dabha tesvik edici 6grenme materyalleri saglayarak 6gretmenin misyonunu basitlestirmek

seklinde siralanabilir.



2. KURAMSAL TEMELLER VE KAYNAK ARASTIRMASI
2.1. Kaynak Arastirmasi

Bu boliim, oncelikle egitim ve okul 6greniminde AG'nin kullanimini ve modern teknolojideki
diger AG uygulamalarina genel bir bakis sunmaktadir.

Cruz ve Cortez (2019) calismalarinda artirilmis gercekligi elektronik laboratuvarlarda
kullanmaya calismislardir. Yaptiklar1 calismada, mantik kapisi entegre devrelerinin (IC) yeterli
sekilde ve kolay 6grenilebilmesi igin akilli telefon tabanli artirillmis gerceklik (AG) sistemini
onermektedirler. Onerilen sistem, temel mantik islemlerini saglayan IC'lerin otomatik olarak
tanimlanmasina izin vermektedir. Konunun anlasilmasinda onerilen sistem gayet Ogreticidir.
Isaretsiz paradigmasi, IC'leri tipik bir devrede tanimlar ve su ii¢ nesneyi yerlestirir: IC
tanimlamasi, mantik diyagrami bilgisi ve pin bilgileri. Son olarak, elde edilen mantik kapisinin

gortintiisiini akilli telefon ekraninda goriintiilenmektedir.

Onime ve ark. (2015) mithendislik 6grencileri igin laboratuvarlarda mikro elektronik 6gretiminin
etkili bir yolu olarak bir AG uygulamasi 6nermektedir. Tasarlanan AG uygulamasi, 6grencilerin
amaglanan 6grenme hedefinin, bir LED titrestirmek (yakip sondiirmek) i¢in 6nceden {iretilmis
panoyu (Seeeduino stalker v2.3) kullanarak deneyi verimli bir sekilde gergeklestirmelerini
saglamaktadir. Bu AG uygulamasi, gercek panoyu ¢ekmek ve sanal bilesenleri (LED ve direng)
gostermek i¢in bir video kamera sensorii kullaniminin yaninda foto gercekg¢i bir isaretleyici
olarak Seeeduino stalker v2.3'in diisik maliyetli bir 2D fotograf maketi kullanilarak
gelistirilmistir. Ogrenci, artirilmis ortamda bilesenleri dokunarak panoya baglamaktadir. Her iki
bilesen de panoya eklendikten sonra LED yanip s6nmeye baslamakta ve yeni bir pencere de

ornek kod programlayicisini gostermektedir.

Odeh ve ark. (2013) uzak laboratuvarlarda artirilmis gercekligin uygunlugunu tartismaktadirlar.
Uzak AG laboratuvari, dgrencilerin bagka bir yerde bulunan deney diizenegi ile miihendislik
deneylerini etkilesim kurmalarin ve gerceklestirmelerini saglamaktadir. Ogrenciler laboratuvarin
ekipmanlarina internet {izerinden kolayca erisebilmekte ve kontrol edebilmektedirler. Beheshti
ve ark. (2017) ¢alismasinda ise devre yapmak, devreden akan elektronlar1 gozlemlemek ve
simiile etmek icin artirllmis gergeklik teknolojisini kullanilmistir. Elektron simiilasyonuna

erigerek ¢cocuklarin elektrik kavramlarini daha iyi anlayabildiklerini gézlemlenmistir.



Miihendislik 6grencilerinin egitimini kolaylastirmak i¢in klasik siniflarda saglanan gercek
kagitlara veya kitaplara ek alternatiflere ihtiya¢ duymaktadir. Calisma, AG kullanarak yeni ve
etkilesimli bir ICT aracinin tasarimini ve gelistirilmesini arastirmaktadir. Miihendislik
ogrencileri i¢in AG Siniflar1 ve AG Laboratuvari konseptini igermektedir. Bununla birlikte, sanal
bir sinif olan AG Sinifi, 6grencinin akilli telefonunda bir mobil uygulama seklinde bulunmakta
ve laboratuvar deneyleri i¢in AG Laboratuvarlari, ¢iktisinin masaiistiinde veya projektorde de

goriilebilecegi yerlerde de sunulmaktadir (Phade ve ark. 2019).

Narumi ve ark. (2015) elle ¢izilmis, basilt ve hibrit iletken miirekkep modellerini taniyarak ve
analiz ederek prototip iletken miirekkep devrelerindeki hatalari algilama ve anlama sorununu
cozen bir ConductAR aract sunmaktadirlar. Kullanicilar, ekrandaki artirllmis gerceklik stili
etkilesimini kullanarak devre islemlerini anlayabilmekte ve gelistirebilmektedir. ConductAR'in
onemli bir unsuru, kullanima hazir bir PC veya tablete baglh bir kamera kullanarak bir devrenin

direncini hesaplama yetenegidir.

Chan ve ark. (2013) elektronik i¢in artirtlmis bir 6grenme platformu olan LightUp'in tasarimini
sunmuslar ve degerlendirmislerdir. LightUp ¢ocuklarin mithendislik ve elektronigi kesfetmesine
yardimc1 olmakta, devreleri olusturmak igin birbirlerini manyetik olarak baglayan bloklara
monte edilen elektronik bilesenlerden (teller, lamba, motor, mikrodenetleyici gibi) olusmaktadir.
Ayrica, devre davranisi hakkinda bilgi saglamaktadir. Bu arastirmada, hesaplama yeteneklerini
elektronik laboratuvarinda (breadboard gibi) yaygin olarak kullanilan fiziksel nesnelere katmay1
ve Ogrencilere yardimci olmak i¢in AG mobil uygulamasindan yararlanmay1 hedeflenmektedir.
Kavramin bir kanit1 olarak iki ¢alisma prototipi onerilmistir. Bunlar (i) AG tabanli laboratuvar el

kitab1 ve devre olusturma uygulamasi ve (i1) Akilli Breadboard (Srivastava 2016).

Ortaokullarda elektrigin temellerinin daha iyi kavranmasi ve popiilaritesinin arttirtlmasi amaciyla
dogru akim elektrik devreleri (DC devreleri), tahrik akimi, devre bilesenleri vb. ile ilgili bazi
temel kavramlarin anlasilmasina katkida bulunmak icin bir AG uygulamasi gelistirilmistir. AG
uygulamasi kullanimmin etkili oldugu kuvvetle fark edilmistir. Smif etkinliklerine 6grenci
katilimin1 motive etme potansiyeli ve 6grencilerin AG kullaniminda 6z-yeterlik olusturmalarini

saglamaktadir (Restivo ve ark. 2014).



Tuli ve Mantri (2015) ogrencilerin 6grenme deneyimini gelistirmek i¢in AG'nin kimya
laboratuvarlarinda nasil kullanilabilecegini gostermektedirler. Sunulan artirilmis gerceklik
uygulamasi kimya laboratuvarinda egitimci/6gretmen ¢alismalarini desteklemektedir. Onerilen
uygulama, laboratuvarda kimyasallarin yanlis kullanim1 nedeniyle 6grencileri herhangi bir zararl
etki veya reaksiyon konusunda uyararak kimyay1 kolay ve etkilesimli hale getirmektedir. Diger
bir makalede ise AG'in getirdigi zorluklar1 ve gelecekteki uygulama Onerileri ele almaktadir
(FitzGerald ve ark. 2012).

Bir diger makalede ise soyut diislince gerektiren geometrik konulari anlamak, kagit, kalem ve
cetvel gibi araglar1 kullanmak, kavram ve kurallarin igsellestirilmesi ve gorsellestirilmesi igin
yeterli olmamasi, bu nedenle, geometri konularinin daha iyi 6gretilmesi ve soyut kavramlarin
somutlastirilabilmesi i¢in egitim teknolojilerinde yeni yaklasimlarin izlenmesi ve kullanilma
gereksinimi incelenmistir. Bu konuyla ilgili Ibili ve Sahin (2013) ¢alismalarinda artirilmis
gerceklik kullanarak 6. sinif matematik kitabi geometrik nesnelerinin zenginlestirilmesiyle 3D
bir geometri kitab1 hazirlamiglardir. Artirilmis gerceklik geometri kitab1 (ARGE3D) yazilimi igin
Visual Studio 2012 platformu ve Slartoolkit'den faydalanilmustir.

Diger bir calismada ise bulmaca oyunlar1 ile etkilesimleri yoluyla Ogrencilerin 6grenme ve
algilama stillerini analiz etmektedirler (Feldman ve ark. 2014). Kesim ve Ozarslan (2012) AG
teknolojilerini ve mevcut herhangi bir kitabi yayinlandiktan sonra artirilmis bir gergeklik
baskisina doniistiirme olasiligini tartisarak ders kitaplarini dinamik bir bilgi kaynagi haline
getirilmesini degerlendirmistir. Bu sekilde, bilgisayar arka plan1 olmayan kisiler hala zengin bir
etkilesimli deneyime sahip olabilecegi One siiriilmiis ancak bunun teknik detaylar
incelenmemistir. Bagka bir calismada, c¢ocuklarin hayal giiclinii ve erken 6grenmelerini
gelistirmek i¢in AG teknolojisini kullanan egitici sihirli oyuncaklarin (EMT) kullanilmasi
onerilmektedir (Yilmaz 2016).

Lee (2012) calismasinda artirilmis gergeklik, egitim, 0gretim ve is diinyasi icin nasil gecerli
oldugu ve egitimin gelecegi lizerindeki potansiyel etkisi aciklanmaktadir. Juan ve Beatrice
(2011) ¢esitli egitici eglence uygulamalari sunar ve insan viicudunun i¢ini 6grenmek igin bir AG
uygulamas1 sunar. ilk olarak, oyun cocuklardan erkek veya kadm bedenini se¢melerini ve
ardindan beklenen organin bulundugu fermuari agmalarini istemektedir. Goriintiileme igin bir

HMD ve bir monitdr kullanilmistir. Diger bir ¢alismanin amaci ise AG'in hem olumlu hem de
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olumsuz yonlerini ve dig mekan ortamlarina nasil dahil edilecegini tanimlayan pratik bir tanimini

vermektedir.

Re ve ark. (2016) AG teknolojisine dayali manuel endiistriyel gorevler sirasinda operatorleri
desteklemek icin bir prototip onermektedirler. Calisma 6zellikle operatore talimatlar saglamak
icin monitor tabanl artirillmis gergeklige bir ¢oziim olarak yogunlasmaktadir. Talimatlar
dogrudan gercek caligma alaninin video gosterimine yiiklenmekte ve standart bir ekranda

gorlintiillenmektedir.

Wei Kan ve ark. (2011) ¢alismalarinda QR kodu olarak adlandirilan iyi bilinen bir 2D barkodu
incelemekte, ardindan bir dizi isaretgi veya etiket tabanli AG teknolojisini arastirmaktadirlar. Bir
iirliin tanitim sistemi ve bir cep telefonu uygulamasi olmak {izere iki uygulama sunulmaktadir.
Uriin tanitim sistemi icin bir iiriiniin paketine bir QR kodu yapistinimaktadir. Bu sistem,
miisterilerin QR Kodundaki paketin igerigini 3D formatinda goriintiileyerek iiriinii
gorsellestirmelerini saglamaktadir. Diger sistem QR kodlarmi ve AG'yi birlestiren bir mobil
uygulamadir. Gu ve B.L. Duh (2011) c¢alismanin amaci, halihazirda kullanilan AG
kiitliphanelerini ve mobil oyun motorlarin1 incelemek ve ardindan mobil AG uygulamalar

gelistirmek i¢in miikemmel bir sekilde uygun bir 3D mobil oyun motoru gelistirmektir.

Literatiirde/uygulamada goriintii giidiimlii cerrahiye entegre edilen birgok artirilmis gerceklik
teknikleri 6nerilmektedir. Goriintii glidiimli cerrahi, goriintii gorsellestirme ile ameliyat yapmak
icin kullanilan genel bir terimdir. Bu tip ameliyatlar1 gerceklestirmek i¢in, once kiigiik bir
insizyonla insan viicuduna cerrahi bir alet yerlestirilmeli ve daha sonra kilavuz goriintiiler
ameliyat icin hedeflenen alanin {izerinde goriinmelidir. Bu prosediir, cerrahi prosediirlerin
invazivligini azaltmaya ve tedavide dogruluklarini ve giivenliklerini artirmaya yardimeci
olmaktadir (Liao 2011). Yardimct Teknoloji (AT) ve Rehabilitasyon Miihendisligi (RE)
uygulamalarinda artirilmis gercekligin, yaslhilar1 ve engelli kisileri gergeklestirmede zorluklarla
karsilastiklar1 gorevleri yerine getirmelerini kolaylastirmak igin 6nemini agiklamaktadirlar (Ong
ve ark. 2011). Diger bir ¢alisma, AG'nin bir cep telefonunda tibbi cihaz verilerini yakalamak igin
nasil kullanilabilecegini ve gelismekte olan iilkelerdeki saglik calisanlar1 tarafindan
gerceklestirilen veri kayit gorevlerinin otomatiklestirilmesine agiklik getirmektedir (Chamberlain
ve ark. 2016).



Baska bir ¢alismada ise artirilmis gerceklik platformu AG Genie ile Nesnelerin interneti (IoT)
hizmetinin toplanmasiyla bir oyun gelistirilmistir. 10T hizmeti, AG tabanli uygulamalar
kullanarak g¢evresel verileri saglayan ekoNET platformu tarafindan alinmaktadir. Gelistirilen
oyun, hava kalitesinin ve sicaklik, hava basinci ve nem gibi diger atmosferik parametrelerin
gercek zamanli izlenmesini saglamaktadir. Oyunun temel amaci, AG teknolojisini kullanarak
cevresel verileri eglenceli ve egitici bir sekilde gorsellestirerek hava kirliligi sorunlarinin
farkindaligini artirmaktir (Pokric ve ark. 2015). Diger bir ¢aligmada ise kullanicilarin bir lazer
yazict lizerinde gorlinen sanal gozlemleri gorebildikleri ve makineyi nasil onaracaklarini

gosteren artirilmis gergeklik arabirimi gelistirilmistir (Feiner ve ark. 1993).

Chen ve ark. (2016) Otizm Spektrum Bozuklugu (ASD) olan ¢ocuklarin dikkatini giiglendirmek
ve ¢ekmek icin AG tabanli bir video modelleme hikdye kitab1 kullanmaktadirlar. Zihinsel
Engellilik (ID) ve Otizm Spektrum Bozuklugu (ASD) olan iiniversite 6grencilerine 6gretmek
icin marker tabanli bir AG teknolojisinin etkilerini inceleyip, bir mobil uygulama kullanarak

daha otantik bir sekilde farkli goriintiileme deneyimi saglanmaktadir (McMahon ve ark. 2015).

Verilen literatiirdeki higbir calisma, AG uygulamalar1 gelistirme yontemlerinin ayrintili bir
aciklamasini saglamamistir. Bu nedenle bu eksiklikleri giderecek bir ¢alismaya ihtiyag vardir.
Dolayisiyla, bu tezde yapilan ¢aligma bu eksiklikleri ortadan kaldiracak ve ayrica elektronik
devrelerin 6gretilmesi icin artirilmig gergeklik tabanl bir platform gelistirme ve otomatiklestirme

konusunda bir yaklagim saglayacaktir.

2.2. Kuramsal Temeller

Bu alt boliimiin amaci; gerceklik, sanallik, sanal ve artirilmis gergeklik kavramlarini ayrintili bir
sekilde agiklamaktir.

2.2.1. Gergeklik

Bir¢ok insan gercekligi gozler ve diger duyular aracilifiyla goriilebilen veya etkilesime
girebilecek seyler olarak tanimlamaktadir. Insanlar her seyi goremezler, bdylece gerceklik
yalnizca goriilebilen veya dokunabilen seylerle sinirli olmamaktadir. Ornegin mikroskoplar
olmadan, atomlari; teleskoplar olmadan gezegenleri gibi belirli cihazlar olmadan bazi var olan

gergekleri gozlemlemek miimkiin olmamaktadir.



Insanlar gergekligin ancak duyulariyla farkina varabilmekte, bu yiizden de sadece gerceklik
algilar1 tanimlanabilmektedir. Bu perspektiften gergeklik, insanin i¢inde bulundugu fiziksel alana
stkismaktadir. Dig diinyanin ger¢ek olmasina ragmen, gerceklik su anda goriilebilen veya
yasanabilen seylerle sinirlidir, gerisi insanoglunun hayal giiciimiiziin bir pargasidir. Gergeklik
ayni zamanda zamansal bir bilesendir. Su anda deneyimlenebilen nesnelerin gelecekte de ayni

kalacaginin garantisi yoktur, ¢linkii gelecek tahmin edilememektedir.

Gergeklik insanin duyulartyla ve onu kisiden kisiye farkli kilan seylerle sinirhidir. Herkes ayni
seyleri gorebilir; ancak anlamlari, hisleri, tatlart vb. duyulara gore degisebilmektedir (Janssen

2011).

2.2.2. Sanallik

Sanallik, kelime anlami olarak “gercekte veya adda olmasa da yiiriirliikkte veya 6ziinde olan bir
sey”’1 belirtmektedir. Sanal sozcligli neredeyse her bilgisayar tarafindan iiretilen veri veya
goriintli icin kullanilmaktadir. Diger yandan bilgisayar tarafindan {iretilen her seyin sanal

olmadig1 gbzden kagirilmamalidir.

Sanallik, kullanic1 ve bilgisayar arasinda bir tiir etkilesim yapilmasini saglar. Ornegin, insan bir
web sitesine goz atabilir ve herhangi bir etkilesim olmadan onu okuyabilmektedir. Aksi takdirde,
sanal diinya insan komutlarina yanit vermek ve onunla etkilesime girmek zorundadir (Janssen
2011). Sanal sey ancak ondan Once gercek bir sey olusturuldugunda/yaratildiginda etkilidir
(Norton 1972).

2.2.3. Gergeklik-Sanallik Siirekliligi

Gergeklik-sanallik siirekliligi, tamamen sanal ile sanallik ve tamamen gergek ile gerceklik
arasinda degisen bir Olgektir. Baska bir deyisle, tim gercek ve sanal nesneleri ve
kompozisyonlar1 icermektedir. Konsept ilk olarak Paul Milgram tarafindan tamitilmistir

(Wikipedia 2020 ).

Sekil 2.1'deki siirekliligin en solunda sadece gercek nesneler (gercek ortam) bulunurken, en
sagda ise sadece sanal nesneler (sanal ortam) bulunmakta ve aralarinda karisik gerceklik alani

(artirilmis gergeklik ve artirilmis sanallik) vardir.



Sanal
Gergeklik (SG)

(sanal ortam)

Gergek diinya Artirllmig Artirlimis
(gergek ortam) Gergeklik (AG) Sanallik (AS)

Karma Gergeklik (KG)

Sekil 2.1. Gergeklik-sanallik siirekliligi

Stireklilik, artirilmis gerceklik (AG) ve artirilmis sanallik olmak tizere iki farkli karma gerceklik
tiriini gostermektedir (Sekil 2.2). Artirllmis sanallikta ortam, gergek olanlardan daha fazla sanal
nesne igermektedir. Dogas1 geregi, siirekliligin merkezi gercek ve sanal nesneler arasinda bir
denge durumunu temsil etmekte; ancak Milgram bunu ger¢ek diinyanin sanal diinyayla
milkemmel bir sekilde birlestigi varsayimsal bir durum olarak isaret etmektedir. Siireklilik
boyunca soldan saga gitmek, azalan bir gercekligi (veya gercek nesneleri) ve artan sanalligi
(sanal nesneler) temsil etmekte ve sanal gergeklik noktasinda artik gergek nesneler yoktur

(Milgram ve ark. 1994).

Karma Gerg¢eklik
(MR)

|Artmlmt§ Gergeklik (AG)‘ i Artirilmis Sanallik (AS) ‘

Sekil 2.2. Karma gerceklik tiirleri

2.2.4. Sanal Gergeklik (SG)

Rheingold ve ark.’a gore (1991), sanal gercekligi (SG) bir kisinin “lic boyutlu bilgisayar
tarafindan olusturulan bir temsil ile ¢evrili oldugu ve sanal diinyada hareket edebilir ve onu farkl
acillardan gorebilir, ona ulasabilir, yakalayabilir ve yeniden sekillendirebilir” olarak

tanimlanmaktadir. Sanal gerceklikte kullanicilar tamamen sanal ortama sokulur/batirilir ve 3B
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diinyalarla etkilesime girebilmektedir. Kullanic1 aslinda sanal diinyanin i¢indeymis gibi

hissetmelidir. Sanal gerc¢eklik kullanicinin alternatif gergekligi olmalidir (Janssen 2011).

Coates'e gore (1992) sanal gerceklik, son kullanicinin gergekei ti¢ boyutlu durumlarda etkilesime
girmesini saglayan, basa takilan gozliikkler ve kablolu giysilerle yasanan ortamlarin elektronik
simiilasyonlaridir (Steuer 1993). Kullaniciyr dinamik olarak etkilesime sokmak, SG bilissel
yapmak i¢in gereklidir; ¢ilinkii kullanici, dogal davranisinin aninda ve gozlemlenebilir bir etki
yarattig1 sanal ortamda aktif ve biligsel bir katilimcidir. Bu durumda, kullanici dijital bilgisayar /
cevre, uzay veya dijital olarak yaratilmig diinyada kendini kaybetme dalgilig1 veya psikolojik

tecriibesi ile karsi karsiya kalabilir (Onime ve ark. 2016).

SG sistemleri, verilen daldirma derecesine gore genellikle asagidaki {i¢ seviye ile

siniflandirilirlar (Onime ve ark. 2016)

e Siiriikleyici olmayan SG sistemleri genellikle ortamin stereo bir goriiniimiinii saglamaz,
sanal ortam bilgisayar ekraninin hemen iginde gerceklesir ve kullanicilar klavye, fare vb.
araciligtyla bu ortamla etkilesime girebilir.

e Yan siiriikleyici SG sistemleri, bilgisayar tarafindan olusturulan ortamin daha biiytlik
goriinlimiinii saglar. Yar siirliikleyici SG sistemlerinde, genis ekranli cihaz, 6zel g6z
giysisi veya gozliikleri, genellikle ¢ubuklar ve 6zel eldivenler gibi 6zel giris cihazlar
kullanilir. Kullanict hem sanal ortami (bilgisayar tarafindan olusturulan) hem de gergek
ortami gorebilir.

e Tamamen siiriikleyici SG sistemleri, ger¢cek diinya ortamina yapilan referanslart kaldirir.
Bu durumda, monte edilmis ekranlara sahip 6zel kask cihazlar1 veya kullaniciyi, zemin ve
tavan dahil tiim duvarlarin temelde biiylik ekran monitorlerle degistirildigi MOSO
(Magara Otomatik Sanal Ortami)’lar adi verilen 6zel olarak tasarlanmis odalarda izole
edilerek kullanilir. Tamamen siiriikleyici ortamlar, giris i¢cin kullanicinin hareketini ve
mimiklerini izler veya istege bagli olarak ¢ubuklari kullanir ve kullanicinin yoniinii de

izler.
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Sekil 2.3. Sanal ortam kurulumuna bir 6rnek: Kameralar (A), katilimcinin odadaki konumunu
gosteren bir optik sensorii (B) izler. Bir ivmedlger (C) katilimcinin kafa hareketleri hakkinda
bilgi toplar. Bu bilgi, odanin nasil olusturuldugunu ve katilimcinin basa takilan ekranda (E)
gordiiklerini belirleyen bilgisayara (D) iletilir (Fox ve ark. 2009)

2.2.5. Artirillms Gergeklik (AG)

Artirilmig gerceklik (AG) 1960l yillarda diinyaya tanitilmig, ancak 1990'lara kadar bir arastirma
alan1 olarak kabul edilmemistir. Bugiinlerde ise biiyliyen bir aragtirma alani olmaya devam
etmektedir. AG'nin bir¢ok tanimi vardir ve birgogu belirli bir alan veya baglamdaki kullanimini

yansitmaktadir (Wikipedia 2020).

Artirilmig gergeklik, gerceklik ve sanallik arasinda bir spektrum tizerindedir (Sekil 2.1). Azuma,
AG'yi sanal ortamlarin (SO) bir ¢esidi olarak tanimlamaktadir. SO teknolojileri bir kullaniciyi
tamamen yapay bir ortama sokmaktadir. Daldirma sirasinda, kullanici cevresindeki gergek
diinyay1 géremez. Ote yandan AG’de, sanal nesneler gercek diinya ile drtiisiir veya birlestirilir ve
bu, kullanicinin hem gercek hem de sanal diinyayr gormesini saglamaktadir. AG; “gergegi
tamamen degistirmek yerine gercegi tamamlar. Ideal olarak, kullaniciya sanal ve gergek

nesnelerin ayni1 alanda bir arada varligin1 hissettirir” (Azuma 1997).

Milgram ayn1 zamanda AG'yi, bilgisayar tarafindan iiretilen veya dijital verilerin kullanilmasiyla
fiziksel diinyanin gelismis (artirtlmis) gortiniimii olarak tanimlamaktadir (Milgram ve ark. 1994).

Ucgiincii bir tanmimlama da Boeing tarafindan yaymlanan ve Memi'nin artirilmis gercekligi
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“Gergek diinyaya iliskin grafik eklemelerini kaplayan bir makine vizyonu ve bilgisayar-grafik
teknolojisi. AG'min ayirt edici 6zelligi, grafiklerin mekansal olarak kaydedilmis olmasidir; yani,
goriintiilenen sahnede gercek nesnelerin konumlarina gore konumlandirilirlar” seklindedir
(Memi 2006). Bu tanimda, AG tamamen gergek diinyaya grafiksel eklemelerle sinirlidir. Azuma,
artirllmis  gergekligin tiim duyulara uygulanabilecegini ve gorsel eklemelerle sinirli olmasi
gerekmedigini savunmaktadir. Simdiye kadar arastirmacilarin “gercek ve sanal goriintiileri ve
grafikleri harmanlamaya” odaklandiklarini, ancak artirilmis gercekligin sesi igerecek sekilde
genisletilebilecegini de Onermektedir. “Baska bir 6rnek haptiklerdir. Dokunsal geribildirim

saglayan cihazlara sahip eldivenler, ortamdaki gercek kuvvetleri artirabilir” (Azuma 1997).

Artirllmis  gercekligi belirli teknolojilerle smirlamaktan kac¢inmak ig¢in Azuma, artirilmis

gercekligi li¢ 6zellige sahip sistemler olarak tanimlamaktadir:

1. Gergek ve sanali birlestirir.
2. Gergek zamanli etkilesimlidir.

3. Ug boyutlu olarak tescil edilmistir (Mekni ve Lemieux 2014).

Azuma ayrica, artirtlmis gercekligin sadece gercek diinyaya nesne ekleme yetenegine degil, ayni
zamanda bunlar1 kaldirma olasiligina da sahip oldugunu savunmaktadir. Bir 6rnekte, kullanict bir
prototip i¢ tasarim uygulamasinda mobilya modellerini degistirmek icin ger¢ek bir kiirek
kullanmaktadir. Kullanict mobilya parcalarini segebilmekte, bir odaya birakabilmekte, istenen
yerlere itebilmekte; itme, egme, vurma gibi diger hareketlerle odadan ¢ikarabilmektedir (Azuma

ve ark. 2001).

v Koo

e ok

Sekil 2.4. Kullanici modelleri almak, tasimak, birakmak ve yok etmek i¢in gercek bir kiirek

kullanir
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2.2.6. Sanal Artirllmis Gergeklik

AG'nin gorsel formunda amag, sanal nesneleri gercek diinyadaki nesneleri gelistirmek veya
desteklemek i¢in kullanicinin gercek diinyaya sahip oldugu net (seffaf) goriiniime birlestirmektir.
Gergek ve sanal kombinasyonu birlestirmek i¢in iki temel segcenek mevcuttur: optik ve video

teknolojileri (Onime ve ark. 2011).

Transparan basa takilan ekran (HMD), gercek ve sanali birlestirmek i¢in kullanilan bir cihazdir.
Standart kapali goriis HMD'leri, ¢cevrenin dogrudan gergek diinya goriisiine izin vermemektedir.
Ote yandan, bir transparan HMD, kullanicinin optik veya video teknolojilerinin iizerine

yerlestirdigi sanal nesnelerle gergek diinyayr gérmesini saglamaktadir (Azuma 1997).

f Head Graphic
Head Tracker images
tion
Scene focations Sorbors
generator
Real
world
Optical

combiners

Sekil 2.5. Optik transparan HMD kavramsal diyagrami

Sekil 2.6. Hughes Electronics tarafindan iiretilen iki optik seffaf HMD
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Optik seffaf HMD'ler, kullanicinin goézlerinin Oniine optik birlestiricileri yerlestirerek
caligmaktadirlar. Bu birlestiriciler kismen aktaricidir, bdylece kullanicinin gergek diinyay1
gormesini saglamaktadirlar. Ayni1 zamanda bu birlestiriciler kismen yansiticidir, bdylece
kullanici, kafasina monte edilmis monitorlerden birlestiricilerden sigrayan sanal goriintiileri
gormektedir (Sekil 2.5-2.6) (Azuma 1997). Optik seffaf ekranlar, giivenli, ucuz ve paralaks
icermeme (kamera konumlandirmasi nedeniyle g6z ofseti yok) avantajlarma sahiptir.
Kullanicilar giiciin kapali oldugunu gorebildikleri i¢in optik teknolojiler giivenli kabul edilir, bu
da bu teknolojiyi hem askeri hem de tibbi amaglar igin ideal hale getirmektedir. Bununla birlikte,
3D sanal nesnelerin aynalar ve seffaf lensler araciligiyla kombinasyonu dezavantajlar yaratir,
clinkii hem goriintiilerdeki hem de gergek diinya gorsellestirmedeki parlakligi ve kontrasti azaltir
ve bu teknigi dis mekan kullanimi i¢in daha az uygun hale getirmektedir (Krevelen 2007).
Kiyoshi Kiyokawa, baga takilan ekranlarin parlaklik sorununu, tikanacak alanlari opaklastiran
piksellere sahip bir LCD panel kullanarak opak bir kaplama ekleyerek ¢ozmiistiir (Kiyokawa ve
ark. 2003).

Buna karsilik, video goriintileme HMD'leri, digital nesneleri HMD'ye bagli kameranin
yakaladig1 gergek diinyanin canli bir video goriintiisiiniin iizerine yerlestirerek calismaktadirlar.
Ortaya ¢ikan kompozit video goriintiisii kullanicinin géziinde tekrar goriintiilebilmektedir. Bu
durumda, HMD'de gosterilen kamera bakis agisi, gercek diinya ile etkilesimin biraz dogal
olmamasina neden olan kullanicinin kendi gozlerinden dengelenir ve ayni zamanda goriintii
stereografik degildir (Sekil 2.7-2.8) (Kato ve Billinghurs 1999). Bununla birlikte, MR Systems
Lab, goriintiileme sisteminin ve ekran sistemi optik eksenlerinin her bir goz i¢in hizalandig: 51
derecelik yatay goriis alanina sahip nispeten hafif (340 gram) video grafik dizisi (VGA)

¢Oziiniirliiklii video goriintiileme ekrani gelistirmistir (Azuma ve ark 2001).

Head

Tracker
Video cameras

Real
4 ~ World
Scene
generalor

Graphx -
| images
f 1 \ \7
Video compositor \\w/

Sekil 2.7. Video transparan HMD kavramsal diyagrami
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Sekil 2.8. Gergek bir video izleme HMD'si

Performans, video kare hiz1 diistiik¢e de onemli 6l¢iide etkilenebilmektedir. Bununla birlikte, bir
goriintlinilin 1yi bir sekilde kaydedilmesi yalnizca goriintii lizerindeki 2B ekran koordinatlar1 ile
gercek diinyadaki 3B koordinatlar arasindaki iligki hakkinda bilgi gerektirdiginden, bu tiir bir
sistem kolayca elde edilebilir (Kato ve Billinghurs 1999).

Video kompozisyonu birden fazla sekilde yapilabilir. Basit bir yontem, kroma anahtarlama
teknigini kullanmaktir. Daha sofistike bir kompozisyon ise derinlik bilgisi kullanmaktadir

(Azuma 1997).

AG sistemleri olusturmak igin transparan HMD'ler yerine, monitér tabanli yapilandirma da
kullanilabilirler. Sekil 2.9, monitor tabanli bir sistemin nasil insa edilebilecegini tam olarak

gostermektedir (Azuma 1997).
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Sekil 2.9. Monitor tabanli AG kavramsal diyagrama.

Monitor tabanli goriintii sistemlerinde, bilgisayar tarafindan olusturulan goriintiiler gercek
diinyanin canli veya kayith video goriintiileri iizerine analog veya dijital olarak yerlestirilir ve
ardindan  kullanicinin ~ oniindeki  monitorde  goriintiilenir  (kullanict  goriintii  aygitini
takmamaktadir) (Milgram ve ark. 1994). Ekran daha konvansiyonel bir masaiistii monitorii veya
elde tasmnabilir bir ekrandir. Istege baglh olarak, goriintiiler ekranda bir ¢ift stereo gozliik
takilmasin1 gerektiren stereo olarak goriintiilenebilir. Bu AG kurulumu muhtemelen daha
kolaydir, ¢linkiit HMD sorunlarini ortadan kaldirmaktadir (Silva ve ark. 2003).

Bu tir AG, TV endiistrisinde filmlerde altyazi gibi efektler i¢in kullanilmaktadir (Filmler
kaydedilebilir ve yayin sirasinda altyazilar eklenebilir, boylece izleyiciler yalnizca altyazilari

gorilintiileyebilece8i veya kaldirabileceginden sinyallerin karistirilmast hala gercek zamanlidir)
(Onime ve ark. 2015).

2.2.7. Teknolojik Gelismeler

AG sistemleri, gorsel-isitsel yakalama, oynatma aygitlart ve diger dokunsal aygitlar gibi
donanim teknolojik aygitlariin etkinlestirilmesine dayanmaktadir. Bu cihazlardaki teknolojik
gelismeler AG'de 6nemli ilerlemeye yol agmistir (Azuma ve ark. 2001); marker izleme, sistem

kalibrasyonu ve foto ger¢ekei olusturma alanlarindaki bazi 6rnekler sunlardir:

e Normal (rastgele) nesneleri biiyilitme isaret¢isi (Augmentation marker) olarak kullanma
yetenegi: GoOrilintli tanima, artirllmis gerceklik sistemlerinin zorunlu bir bilesenidir.

Artirilmis gergeklik belirtegleri, sanal 6gelerin {ist iiste binmesi igin fiziksel diinya
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nesnelerini tespit etmek ic¢in kullanilan sisteme zaten yerlestirilmis gercek diinyada gorsel
ipuglaridir. AG'nin kameranin gergek diinya gercevesine gore yoniinii ve konumunu
tahmin etmesi icin, ¢ogu uygulama isaret tabanli artirilmis gerceklik olarak bilinen bir
izleme teknolojisi kullanir. AG isaretleri geleneksel olarak 2 veya 3 boyutlu QR
kodlarindan olusmaktadir (AnyMotion 2019). Silhouette izleme gibi yeni gelismelerin
kullannm1 ile artitk kagit, gercek fiziksel nesneler, 3B modeller ve nesnelerin
fotograflarinda rastgele / normal desenler kullanmak miimkiindiir (Behringe 1999).
Isaretsiz artirilmis gerceklik de miimkiindiir, ancak isaretsiz AG referans belirleyici
isaretleyicilerden ziyade bir ¢evrenin dogal 6zelliklerine baglidir (AnyMotion 2019).
Nesnelerin geligmis takibi: Bir kullanicinin goriisiiniin yoniinii ve konumunu dogru bir
sekilde izlemek AG kaydi i¢in kritik 6neme sahiptir (Azuma ve ark. 2001). Bir dis mekan
sisteminde, kullanicinin konumu GPS bilgileri kullanilarak elde edilebilir. Kullanicinin
yonelimini elde etmek icin dijital bir manyetik pusula kullanilabilir. Egim ve egim agis1
bilgisi saglayan egimélcerler de yararli olabilmektedir. I¢c mekan senaryolarinda, bu
yontemler nesnelere takilan veya cevreye yerlestirilen yapay isaretleyicilerden
yararlanabilir (Behringe 1999). Her seferinde tek kisitlama (Scaat) algoritmasi, farkli
giris cihazlarinin otomatik kalibrasyonu ile daha hizli izleme saglayan yeni bir tekniktir.
Video akisi i¢indeki nesne izleme artik yeterince sofistike ve gercek zamanli olarak
kullanilabilmektedir (Welch ve Bishop 1997).

Foto gergekgi olusturma: Olusturma su anda AG'deki en biiyiik sorunlardan biri degildir.
Ancak sanal nesneler olusturuldugunda gercek nesnelerden ayirt edilememesi
gerekmektedir (Silva ve ark. 2003). Sanal nesneler tizerinde daha gercekei bir etki igin
sanal nesnelerin aydinlatilmasina ve bunlarin aydinlatma degerleri ve ¢evresel yansima
izerine yansimasina yaklasan bir¢ok farkli teknoloji vardir (Milsap ve Bourland 2011).
Kayit ve otomatik Slgeklenebilirlik: Kayit sorunu, artirilmis gergeklik uygulamalarini
sinirlayan en temel sorunlardan biridir. Gergek ve sanal diinyadaki nesneler birbirine gore
diizgiin bir sekilde hizalanmalidir (Azuma 1997). Kamera, ekran ve ¢ok ¢ekirdekli
hesaplama islemcileri gibi cihazlardaki gelismeler sayesinde, AG sistemleri artik sanal
nesneleri kullanicinin isaretleyiciden uzakligina gore otomatik olarak genisletebilir ve
Olgeklendirebilir. Sanal nesneler i¢in 3B model veriler mevcut oldugunda, AG sistemi

sanal nesneleri ger¢ek zamanli olarak ve kullanicinin algilanan uzamsal konumuna gore
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tasima ve dondlirme olanagi da saglamaktadir. Kullanici ig¢in, tiim bunlar tableti
isaret¢inin yakinina tagimak veya goriis agilarini degistirmek kadar basittir (Azuma ve
ark. 2001).

2.2.8. Artirllmis gergeklik ve sanal gerceklik karsilastirmasi

2.2.8.1. AG ve SG'nin benzerlikleri

AG ve SG'nin temel benzerlikleri asagida 6zetlenmistir:

Kullanicilara genellikle ayn1 amaca hizmet etmektedir: gelismis veya zenginlestirilmis
deneyim.

Genel olarak daha iyi bir deneyim sunar.

Bir¢ok alandaki uygulamalar i¢in yiiksek potansiyele sahiptir.

Ayni ¢ekirdek programlamaya sahiptir.

2.2.8.2. AG ve SG arasindaki farklar

AG ve SG arasindaki temel farklar asagida 6zetlenmistir (Berryman 2012; Kounavis ve ark.
2012; Stielak 2016; Stapleton 2019):

SG'de kullanict tamamen sanal bir ortama dalmis ve gercek hayattan tamamen izole
edilmistir, oysa AG'de baz1 sanal eklemeler olsa bile kullanic1 yine de gergek diinyaya
dokunabilmektedir.

AG, ger¢ek hayat ilizerine insa edilmistir ve SG tamamen sanal bir diinya iizerine
kurulurken onu daha etkilesimli hale getirmektedir.

AG'de gercek hayat sanal bir ortamla degistirilmez, kullanilan ortam gercekligin gelismis
bir goriiniimiidiir. Tersine, sanal gerceklikte ortam yeniden yaratilir ve tamamen simiile
edilir ve ger¢ekte mevcut degildir.

AG uygulamalarin1 kullanmak, tipki herhangi bir mobil uygulamasini kullanmak gibidir;
SG uygulamalarinda ise HTC Vive, Google Cardboard ve Oculus Rift gibi cihazlarin
kullanicinin tiim goriis alanim1 kaplamasi ve gordiiklerini/duyduklarimi kontrol etmesi
gerekmektedir.

2.2.8.3. AG'nin Avantajlari

AG'nin bazi avantajlar1 agagida 6zetlenmistir (Azuma 1997; Hsiao et Rashvand 2011; Cetinkaya
ve Akgay 2013; Ibili ve Sahin 2013; Sevim 2019; Panono 2020):

Kisisellestirilmis 6grenim sunmaktadir.
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Ogrenme siirecini gelistirmektedir.

Cesitli teknolojiler (telefon, tablet, sanal gozliik vb.) kullanilarak insanlara gergek
diinyadaki fiziksel c¢evre hakkinda detayli bilgi gorsel veya metin yoluyla
saglanabilmektedir.

Egitim, tip, askeri ugaklar, eglence vb. birgok alanda kullanilmaktadir.

Kullandig1 uygulama ve nesnelere dinamizm ve gergekci bir hava katmaktadir.

Ticari sektorde, insanlar ayni ortamlarda nesneleri deneme olanagina sahiptir.

Ogrenci motivasyonunu ve problem ¢dzme yetenegini artirmaktadir.

Soyut kavramlar, AG gibi geometri konular1 kullanilarak somutlastirilabilmektedir.
Konular1 2B-3B modeller, animasyonlar ve videolar ile zenginlestirmektedir.

Kullanicilar deneyimlerini uzun yerlerde paylasabilirler.

Kullanicilara "gercek" bir deneyim saglayan uygulamalarin gelistirilmesine yardimci
olmaktadir.

2.2.8.4. SG'nin Avantajlari

SG'nin bazi avantajlari asagida 6zetlenmistir (Panono 2020; Bardi 2019; Babich 2019):

Siirtikleyici 6grenme ortami sunmaktadir.

Kullanici, bilgisayar tarafindan olusturulan bir goriintii ve ses diinyasina dalmaktadir.
SG'de etkilesimli bir ortam olusturulmaktadir.

Egitim alaninda oOgrenciler arasindaki isbirligi SG uygulamalari kullanilarak
gelismektedir.

Ogrencilerin hayal gii¢lerini ve yaraticiliklarmni gelistirmelerine yardime1 olmaktadir.
Kullanicilarin ~ diinyayr  kesfedebilecekleri gercek¢i bir diinya yaratma firsati
saglamaktadir.

2.2.8.5. AG'nin Dezavantajlari

AG'nin bazi dezavantajlari asagida Ozetlenmistir  (Ibili ve Sahin 2013; Robinson 2010;
Assignment Help 4 Me 2019):

AG uygulamalarii olusturmak i¢in kullanilabilen aygitlar, baz1 kisitlamalara neden olan
yeterli donanim Ozelliklerinden yoksundur. Kullanilan cihazda bellek, grafik giicii,
islemci kapasitesi, internet yetenegi ve benzeri 6geler yeterli olmalidir.

Isik ve giiriiltii gibi gevresel kosullar AG uygulamalarini olumsuz etkileyebilmektedir.
AG kullanan programlarin yazilim hatasi teknolojik {iriin hatalarindan kaynaklanabilir.
Bazi zaman sinirlamalari, uygulamanin diizgiin ¢alismasini engelleyebilir.
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e Kaullanicilar, AG uygulamalar ile birlikte kullanilacak teknolojik araclarmn (Google
Glass, HoloLens vb.) kullanimi1 hakkinda bilgi sahibi olmalidir.

e AG uygulamalari ile kullanilan cihazlar yiiksek maddi/finansal degere sahiptir.

e AQG, zihinsel saglik sorunlarina neden olabilir.

e Giivenlik eksikligi, AG ilkesini etkileyebilir.

2.2.8.6. SG'nin Dezavantajlari
SG'nin bazi dezavantajlari asagida 6zetlenmistir (Nedic ve ark. 2003; Bingo Technologies 2019):

e Giiniimiizde SG yayginlagsa da, programcilar sanal ortamlarla higbir zaman etkilesim
kuramayacaklardir.

e Kacig, SG ortamlarmi kullananlar arasinda yaygindir ve kullanicilar, gergek diinya
problemleriyle ugrasmak yerine sanal diinyada kalmay1 segmektedirler.

e Sanal ortam ile ugragsmak asla gercek olanla ugrasmak gibi olmayacaktir. Kullanici sanal
ortami1 kullanarak bir gorevi basarabilirse, bu onun gercek hayatta ayni seyi yapma
yetenegini garanti etmeyecegi anlamina gelmektedir.

Gergeklik tiirlerinin genel karsilastirmasi: Tablo 2.1'de verilmistir. (Carmigniani ve ark. 2011;
Bamodu and Ye 2013; Billinghurst ve ark. 2015; McMillan ve ark. 2017; Farshid ve ark. 2018;
Li ve ark. 2019; Rokhsaritalemi ve ark. 2020; Wikipedia 2020; Jaquith ve The Futurism Team
2017; Nepal ve Tang 2017; Onirix 2019; Stapleton 2019).

Tablo 2.1. Gergeklik tiirlerinin genel karsilastirmasi

. Artirilmis .
Ozellikler Sanal gerceklik gerceklik Karnsik gerc¢eklik
SG AG KG
Gergek diinyanin Gergek diinyaya Olas1 bilgi ve
Diinya dijital veri ve bilgi | eklenen veriler ve verilerin gergek
ile temsili bilgiler diinyaya girisi
Tamamen yapay / S}ergek dinya Sanal ve gergek
Cevre diii iizerinde sanal .. A
ijital / sanal « diinyanin birlesimi
nesneler / 6geler
Gergek ve sanal
diinyay1
Daldirma Tamarpen sanal Ger({ek"dunyayl birlestirmek icin
diinya biliylitmek gercek zamanli
mekansal
haritalama
Bir mevcudiyet Gergek ortami Gergek olaylarin
Konsept
algis1 ve tam desteklemek, uyarlanmasi
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daldirma

fiziksel birlikte

olusturmak varolusa fayda
eklemek
Hala gercek ortami Hatl;ige;)rrgil; E;triﬁn
. Artik gercek ortami gorliyor, ayrica goruy
Cevreyi algilamak AR nesneler gercek
algilamiyor goriintiilenen ek diinvanin bir
bilgileri aliyor Y
parcast oluyor
Dijital 3D
diinyasini yalnizca | Daha basit yardimci Seffiﬂfiﬁ;ﬁ ECD
Deneyim 0zel yardime1 araglarla & ara larlas
araglarla deneyimleyebilir ag -
; - deneyimleyebilir
deneyimleyebilir
Oran Sanal (¢ok) + Sanal (az) + gercek Sanal (orta) +
gercek (az) (cok) gercek (orta)
Oznitelik Sanal Hem sanal hem de Mix
gercek
3B alanda 3B alanda
kayith Evet aciklamal Evet
=, Kullanici
= alaniyla Hayir Hayir Evet
bagh
Zaman
siirekliligi Hayir Hayir Evet
Etkilesim Sanal nesne ile Fiziksel nesne ile Fiziksel ve sanal
nesne ile
Gériintii cihaz Ozel kulaklik, akilli | Kulakliklar (istege | Kulakliklar (istege
gozliikler bagli) bagli)
Bilgisayarda Bilgisayarda
olusturulan olusturulan
Bilgisayar grafiklerin / grafiklerin /
Gériintii kavnas: tarafindan goriintiilerin ve goriintiilerin ve
yhag olusturulan gercek hayattaki gercek hayattaki
grafikler / resimler nesnelerin / nesnelerin /
ogelerin Ogelerin

kombinasyonu

kombinasyonu

Sanal nesnelerin /
Ogelerin konumu ve
boyutu kullanicinin

Sanal nesneler /
ogeler, kullanicinin

Sanal nesneler /
ogeler, kullanicinin

Perspektif sanal diinyadaki gercek diinya gergek diinya
bakis acisma gore perspekt_iﬁne_ gore perspekt_iﬁne_ gore
degisir tepki verir tepki verir
Bir yere tasginmis Gergek diinyada Gergek diinyada
Varlik gibi bir his var ama | olma hissi, ancak olma hissi, ancak
gercek diinya hissi bir yere tasinan bir yere taginan
yok yeni nesneler / yeni nesneler /
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tizerinde kontrol,
kosu bantlari, ses
girisi, bodysuits,
hareket platformlar
(sanal omni), elle
giyilen cihazlar ve

ciplak elle giris

Ogelerle birlikte ogelerle birlikte
Gergeklikten ayirt Kullanier " Gergeklikten ayirt
. davranigina gore X
Farkindalik edilemeyen sanal edilemeyen sanal
. tanimlanan sanal v
nesneler / 6geler s nesneler / 6geler
nesneler / 6geler
Joystickler, kontrol
cubuklari, veri
eldivenleri, toplar / 2B kullanici
' 1zleme"toplar1, . arayuzl.erl (fare, 6-DOF izleme
izleme dortgenleri, | klavye, isaretleme Sensril. ses irisi
diigmeler, hareket cihazi vb.), 3B ve ’ s,
N . . kameralar, hareket
Giris izleyiciler, cihaz multimodal

araylizler (eldiven,
kablosuz bileklik, el

degnekleri,
konugma, hareket

vb.)

izleyiciler ve
kontrolorler ve
bakis / hareket / ses
tanima cihazlari

Etkilesim araglari

Giyilebilir sensor
cihaz tabanl giris
(veri eldivenleri,
atalet sensorii ve
miyoelektriklik
(EMG) sensort),
dokunmatik cihaz
tabanli giris
(dokunmatik ekran
ve dijital kalem) ve
bilgisayarla gérme
etkilesimi cihazi
tabanli girig

Bilgi tarayicilari,
3B somut dogal
kullanict arayiizleri,
isbirligine dayali
arayiizler,
multimodal
arayiizler, hibrit
arayiizler

Kavranabilir
araytizler

Cikt1 (ekran)

Video goriintiileme
monitorii, basa ve
kulaga takilan
ekipman, stereo
ekran monitorii ve
projeksiyon
ekranlar1 (CAVE
tipi, fishbowl VR
ve IDesk / IScreen)

Video ve
projeksiyon tabanh
ekranlar, optik
seffaf ekranlar, goz
¢oklamali ekranlar,
basa takilan
ekranlar (HMD,
basa takilan
ekranlar), elde
tutulan ve viicuda
takilan ekranlar,
uzamsal ekranlar,
diger duyusal

ekranlar

Head-up display,
magara otomatik
sanal ortam, basa
takilan ekran,
bilgisayar - tablet -
cep telefonu - el
bilgisayar1
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Gelistirme araclar1

Unity, Amazon
Sumerian, Unreal
Engine, CryEngine,
Blender, 3ds MAX,
SketchUp Studio,
Maya, Oculus
Medium,
Lumberyard

Unity, Amazon
Sumerian,
ARToolkit,
0SgART,
Studierstube,
MXR-ToolKit,
FLARManager
Processing,
D'Fusion, Metaio
Creator,
OpenFrameworks,
DART, Wikitude
Studio, Vuforia and
Metaio Unity plug-
ins, EasyAR, Layar
Creator, ARKit,
AR-Media plug-ins,
ARCore, Maxst,
BuildAR

Unity, MRTK,
ARToolkit, Layar,
Vuforia, Zapbox,
Kudan, Wikitude,

OSVR

Kullanim alanlari

Saglik, glivenlik,
askeri, egitim,

Egitim, askeri,
navigasyon, reklam
ve pazarlama,
endiistriyel / i¢
tasarim, turizm ve
seyahat, acil durum
yOnetimi / arama ve
kurtarma, saglik

Egitim, simiilasyon
tabanli 6grenme
(SBL), Etkilesimli
iirlin igerik
yonetimi (IPCM),
askeri, uzaktan

planlamasi, caligsma, islevsel
uygulama ve model,
egitim, yayin ve miihendislik,
canh etkinlikler, eglence ve egitim,
ceviri, miizik, tip
oyunlar, sosyal
etkilesim
Ornekler Oculus Rift, Sony Google Glass, Microsoft
Headset VR Pokemon Go HollowLens MR

24



3. MATERYAL ve YONTEM
3.1. Yazihm Gelistirme Araglari

Mobil igletim sistemleri alaninda/pazarinda temel olarak iki sistem hakimdir: Android ve 10S.
Bu isletim sistemleri i¢in artirilmis gerceklikle uygulamalar gelistirme ara¢ setleri mevcuttur.
Bunlar arasinda ARCore, ARToolKit, EasyAR, Kudan, Maxst, Vuforia, Xzimg vb. yer
almaktadir. Vuforia, belirtecleri algilayan bir uygulamada “dijital g6z” gorevi gormektedir.
Vuforia’nin Artirllmis Gergeklik SDK's1, gercek zamanli goriintii hedeflerini ve temel 3D
nesneleri tanimlamak ve izlemek i¢in bilgisayar gorme teknolojisini kullanmaktadir (Vuforia
2019). ARCore, gevresini ve ¢esitli yiizey ortamlarini algilamada c¢ok daha gelismistir.
Karmagikligina bakilmaksizin herhangi bir 3B nesneyi fiziksel bir yiizeye yerlestirebilir. Ancak,
bu platform sinirli sayida akilli telefon i¢in uygundur (Dudkin 2019). EasyAR, ayn1 anda birden
fazla 3B nesneyi gercek zamanli olarak taniyabilir ve izleyebilir. Bununla birlikte, bazi

kullanicilar EasyAR’1n goriintii istikrari ile ilgili zorluklar bildirmistir (Titov 2019).

Gergeklestirilen tez ¢alismasinda Android isletim sistemi ve basit kurulum prosediirii ile dogru
goriintii takibi nedeniyle Vuforia SDK se¢ilmistir. Bunun yaninda Vuforia; Android, iOS, UWP
ve Unity Editor Platformlari ile uyumludur.

Gelistirme ortam1 se¢imi ise Unity, Unreal Engine ve CryEngine karsilastirilarak yapilmistir.
Unity, iki ve {i¢ boyutlu uygulamalar ve oyunlar gelistirmek i¢in bir aragtir. Bu aracin sundugu
en 1yi Ozelliklerden biri, gelistiricilerin Android, Blackberry, 10S ve Windows arasinda herhangi
bir platformu degistirmesine izin veren ¢apraz platform entegrasyonudur (Mossel ve ark. 2012).
Unity3D iki kodlama dilini desteklemektedir: C # ve JavaScript. C ++ 'a kiyasla Java'dan C #' a
gecis yapma zorlugu olmadigi i¢in bu C ++ 'dan daha fazla tercih edilir. Bununla birlikte, Unity
3D acgik ve hizli bir kullanici arayiiziine sahiptir ve Windows XP Service Pack 2'de (SP2)
calisacak kadar hafiftir (Unity 2020). Unreal Engine, Epic Games tarafindan gelistirilen ve
desteklenen oyun motorudur. C ++ ile yazilmis motorla, ¢ogu isletim sistemi ve platform igin
oyunlar gelistirilebilir (Educha 2020). CryEngine ise giiniimiizdeki en gii¢lii ve baskin oyun
motorlarindan biridir. CryEngine'i ayiran baslica 6zelleikler, grafiksel yetenekleridir. CryEngine
agir ve gii¢lii bir oyun motoru olmasina ragmen, bu platformu etkili bir sekilde kullanmak biraz
zaman almakta ve daha 6nce baska bir oyun motoru kullanmayan yeni baslayanlar i¢in anlamasi

biraz daha zordur. CryEngine, C #, Lua ve C ++ "1 desteklemektedir (Educba 2020). Bu
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karsilagtirmalar dogrultusunda Unity 3D segilmistir. Ayrica Unity 3D, Vuforia SDK'y1

desteklemekte ve lcretsiz bir sirimi mevcuttur.

3.2. Yazihm Araclarimin Kurulumu

Bu calismada Unity 2019.2 (64 bit) 3D oyun motoru ve Vuforia 8.5 SDK (yazilim gelistirme
kiti) kullanilarak AG uygulamasi gelistirilmistir. AG ortamini olusturmak i¢in atilacak adimlar
asagidaki gibi 6zetlenebilir:

e Vuforia Motor Kurulumu

Boyle bir proje i¢in, https://developer.vuforia.com/ adresinden kullanici kaydi gereklidir. Projeye

baslamadan once, https://developer.vuforia.com/downloads/sdk adresinden “Add Vuforia Engine

to a Unity Project” eklentisini indirilir (Sekil 3.1). Bu eklenti, Vuforia gelistirme kitinin Unity

oyun motoruna entegre edilmesini saglamaktadir.

C 8§ daveloperwifonacom/ oy

Vuforia Engine 8.6

&

Use Vularia Engine 1o bulld Augmented Reality Android, 1085, and UWP
ipplicatons for mobile devices and AR glasses, Apps can be bullt with Unity
Android Studio, Xcode, and Visual Studio. Vuforia Engine can also be
sccessed through the Unity Package Manager hy adding Vuforia's package
repasitory with the script below

Add Vuforia Engine to a Unity Project or upgrade to the latest
unity

version

add-vuforia-package-8-6-7 unitypackage (2.30 KB)

Download for HoloLens Development in Unity 2018.4
Sunity ;

VuforiaSupportinstaller-Windows-8-6-7.21p (109,50 MB)

’ Download for Android
vuforia-sdk-android-8-6-7.2ip (26.16 MB)

Sekil 3.1. Vuforia SDK Unity eklentisi

Unity 2019.2 ve sonrasinda Vuforia paketleri, kapsamli bir DPY (Diigiim Paketi YOneticisi)
kayit  defteri araciligiyla  edinilebilir.  Bununla ilgili daha fazla bilgi i¢in
https:/library.vuforia.com/content/vuforia-library/en/articles/Solution/vuforia-engine-package-

hosting-for-unity.html adresine bakilabilir.
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Unity 3D motorunu kurulurken, Bilesenler se¢im iletisim kutusundaki platform destegine (i0S,
Android, UWP) ¢k olarak Vuforia Artirtlmis Gergeklik Destegi'ni de segmek gerekmektedir.
Vuforia, Unity'nin paket yoneticisi kullanilarak herhangi bir projeye eklenebileceginden, Unity
2019.2'den itibaren buna gerek yoktur. Kurulumdan sonra indirilen Vuforia eklentisi Unity'ye
aktarilmalidir (Sekil 3.2).

Download And Install Unity

Unity component selection

Component Download Size Installed Size
Introduction Unity 2017.2.013 821 MB 2.13GB
J Documentation 275 MB 490 MB
License Standard Assets 189 MB 185 MB
o Components Example Project 310 MB 520 MB
Dasiiidiior catas Android Build Support (*) 159 MB 395 MB
X iOS Build Support (*) 1.14GB 2.63GB
DOWn|030 tvOS Build Support (*) 390 MB 955 MB
Installation B Vuforia Augmented Realit... 62.0 MB 117 MB
Summary SamsungTV Build Suppor... 42.4 MB 120 MB
Tizen Build Support (*) 84.7 MB 210 MB
WebGL Build Suoport (*) 276 MB 706 MB
(*) Indicates that the vent requires Unity 1o be installed
Space Required: 4.38 GB Space remaining: 246.77 GB
g Allows building your Unity projects for the Windows platform
& unity

Sekil 3.2. Unity'yi indirmek ve yiiklemek

e Vuforia Lisans Anahtar1 Olusturma

Vuforia web sitesinden Gelistir'i ve ardindan da Gelistirme Anahtari'm1 tiklayarak lisans
yOneticisi sekmesinden bir lisans anahtar1 olusturulmalidir. Vuforia, her uygulama i¢in benzersiz

bir lisans anahtar1 gerektirmektedir (Sekil 3.3).
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License Manager  Target Manager

3 AR Demo

AR DeMmMO :airame petste License <

Liconsa Key

Please copy the license key below into your app

ey

Plan Type: Develop

Status: Active

Created: Dec 22, 2019 13:03

Sekil 3.3. Vuforia lisans anahtar1 olusturma

e Yeni bir Unity projesi olusturma

3D sablon segilip projenin adi ve konumu belirlenmekte, ardindan "Create” diigmesine

basilmaktadir.

€ Create a new project with Unity 2019.2.12f1

Templates

High Definition
RP

N_
3D
®
—_—

LWRF Template

Settings

@ Project Mame *
Unity 2019.2 AR Test Prject

¢

3D With Extras

Location *

Ch\Users\sanai

CANCEL

Sekil 3.4. Yeni bir Unity projesi olusturma
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e  Unity projesinde Vuforia Engine'in etkinlestirme

Vuforia Engine uygulamasi olusturmadan veya Vuforia Engine'i Play Mode'da kullanmadan
once Vuforia Engine projede etkinlestirilmelidir. Ilk olarak, Olusturma Ayarlari'na gidilir ve
uygulamanin olusturulacagi mobil cihazi secilir (Sekil 3.5). Ardindan "XR Ayarlar1" boliimii
altinda Vuforia Motorunu etkinlestirmek i¢in Oynatic1 Ayarlari'na gidin ve "Vuforia Augmented
Reality Supported"” se¢enegini isaretlenir (Sekil 3.6).

Build Settings B

Sekil 3.5. Calisilacak mobil cihaz tiiriinii segme
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Sekil 3.6. VVuforia motorunu etkinlestirme

e Vuforia Motor Oyun Nesneleri (Vuforia Engine)

Vuforia'y1 etkinlestirdikten sonra, Unity Oyun Nesnesi (Game Object) meniisiinde Vuforia

Motoru (Vuforia Engine) goriiniir olmalidir (Sekil 3.7).

€@ Uniy 20192 AR

rject - SampleScene - Android - Unity 2019.2.12f] Personal <DX11>

bject Cm Window  Help
Create Empty Ctrle ShifteN
Create Empty Child AlxeShifteN

Centes On Chidren

Make Parent
Cloas Paventt

Set es first siifing
Set #s lest ubling

Sekil 3.7. Vuforia motor oyun nesneleri (VVuforia Engine Game Objects)
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e Unity'de Vuforia Engine 6zelliklerine erisme

Unity Game Object meniisiinden Vuforia Engine'in 6zellikleri projeye eklenebilir. Daha fazla

bilgi i¢in https:/library.vuforia.com/features/overview.html adresinden faydalanilabilir. Sekil

3.7.°de gosterildigi gibi bir AR Kamera ekleyerek baslanmistir (Ana Kamera silinmistir). AR
kamera, hem elde tasinir cihazlar hem de dijital gozlik igin artirilmis gergeklik uygulamalarini

destekleyen 6zel bir kamera tiiriidiir.

Vuforia kurulumunun tamamlanmasi i¢in Vuforia Gelistirici Portali'nda olusturulan uygulama
lisans anahtarini girilmelidir. Bunu yapmak i¢in, Hiyerarsi sekmesinde (Hierarchy tab) AR
Kamera segilir ve agsagidaki Inspector window penceresinde Vuforia Motor Yapilandirmasin Ag

(Open Vuforia Engine Configuration) butonuna tiklanilir (Sekil 3.8).

= Hierarchy a= 0 Inspectr - . W

| Create~| @@an )| =ves AL TR pepL

oY QSamplefcene_* “=| v¢& ¥ Camera @ = %
i | Directional Light Clear Flags | Solid Color 3]

Background I ¢
Culling Mask Everything $

Prqjection | Perspective 3]
FOV Axis | Vertical 4|
Field of View — e [60 |

Physical Camera ||

Clipping Planes Near (0.05
Far 2000
Viewport Rect
X0 Y 0
wi1 JHL :
Depth 1. =
Rendering Path | Use Graphics Setting 4 |
(1 Target Texture W o}
& Prect Occlusion Culling &
] Create '| HDR | off :)
¥ | ;Favorites Assets MSAA | Use Graphics Setting 4 |
@AII Materials ~ Allow Dynamic Resoll_|
©\ All Models —
(L All Prefabs (© ¥ Audio Listener |
v & ¥ vuforia Behaviour (5 o ﬁv‘
Download new Vuforia Engine versiont 8.6,
& Resources Resourc -
Scenes World Center Mode | DEVICE +
i Packages

¥ = ¥ Default Initialization [ 3! %,
Script DefaultInitializa @

Sekil 3.8. Vuforia motor yapilandirmasinin agilmasi (Open Vuforia Engine Configuration)
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Daha sonra lisans anahtarin1 kopyalanip Uygulama Lisans Anahtar1 alanina (App License Key)
yapistirilir. Vuforia kurulumunu tamamlamak i¢in son olarak Lisans Ekle (Add License)

butonuna tiklanir (Sekil 3.9).

6 inepecor I

Qpen Library Article

I Add License I

Delayed Initialization| |

Camera Device Modé MODE_DEFAULT
Max Simultaneous Tr1 |
Max Simultaneous Tr1 |
Load Object Targets ||

Trained Targets Contis

aF
s

Sekil 3.9. Lisans anahtar1 eklenmesi

Bu islemler sonucunda Vuforia-Unity 3D projesinin yapilandirmasini tamamlanmaktadir. Bu

adimlardan sonra AG uygulamasi olusturulur.
e  Goriintii hedeflerini yapilandirma

Vuforia Gelistirici Portali'nda goriintii hedeflerini ayarlamak i¢in Hedef Yoneticisi (Target
Manager) sayfasini agilir. Hedef goriintii veritabaninin (target image database) eklenmesi i¢in

Veritaban1 Ekle diigmesine (Add Database button) tiklanilir (Sekil 3.10).

engine

developer portal

Home Pricing Downloads Library Develop Support

License Manager  Target Manager

Target Manager

Use the Target Manager to create and manage databases and targets,

Sekil 3.10. Veritabani eklenmesi
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Kullanilacak veritabaninin adi girilir, tiir olarak da Aygit (Device) secilir ve Olustur (Create)
butonuyla yeni bir veritabani eklenir (Sekil 3.11). Bu asamadan sonra Hedef Y6netici sayfasinda

eklenen veritabani, veritabanlari listesinde goriinecektir.

Create Database

AR images

Type:

* Device

Cloud
VuMark

Sekil 3.11. Veritabani olusturulmast

Sanal nesneler i¢in hedef gorevi gorecek goriintiileri eklemek i¢in ilgili veritabam agilir (Sekil
3.12) ve ardindan hedef goriintiileri bulmak/se¢mek i¢in Hedef Ekle (Add Target) butonuna
tiklanilir (Sekil 3.13).

Target Manager

Use the Target Manager to create and manage databases and targets,

Database Type Targets Date Modified
AR_images Device 2 Mar 16, 2020
Eleclab Device 10 Mar 24, 2020
simpledemo Device 1 Dec 02, 2019

Sekil 3.12. Veritabaninin agilmasi
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License Manager  Target Manager

» AR_Images

AR_images - ..

Type: Device

Targets (0)

Acd Tarzot Download Database (All)

srget Name Type Ratng Status v Date Modified

Sekil 3.13. Goriintii hedefleri eklemesi

Vuforia dort tiir hedefi desteklemektedir: tek gériintii, kiiboid, silindir ve 3D nesne. Istenilen tiir
secilerek uygun 6geyi bulmak i¢in bilgisayara goz atilabilmektedir. Uygulamada - hedef olarak
kullanilacak - Tek Goriintii (Single Image) secilmistir (Sekil 3.14).

Type:
Single Image Cuboid Cylinder 3D Object

Sekil 3.14. Hedefin tiirlinli se¢imi

Resim adin1 ve genisligini, Unity3D'nin boyut referansi olarak kullanabilecegi sekilde
ayarlanmaktadir. Vuforia ayrica kameranin goriintiiyli ne kadar kolay gorebildigini gosteren

yildiz derecelendirmesini eklemektedir. Bu uygulamada 5 yildiz hedeflenmistir (Sekil 3.15).
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Uconse Manager  Target Managor

» AR amapes
AR_images
Type: Device
Targers (2)
Aokl Targes Domrvaad Database (1)
Targel Name Type Ratin SLATLS Date Madified
sefectod
3 ang Single Image E Active Mar 16,2020 11:50

Sekil 3.15. Resim hedeflerini yiiklenmesi

Son olarak, veritabaninin Unity3D'de kullanilabilmesi i¢in indirilmesi gerekmektedir. Sekil
3.15'te gosterildigi gibi Veritabanim Indir (Download Database) butonuna tiklanir ve gelistirme

platformu olarak Unity Editor'i secilir (Sekil 3.16).

Download Database

1 of 1 active targets will be downloaded

Name:
AR_images

Select a development platform:

Android Studio, Xcode or Visual Studio

® Unity Editor

Cancel Download

Sekil 3.16. Veri taban1 indirmesi

35



e Sahneye goriintii hedefleri ekleme

Indirilen veritabani agildiktan sonra Unity'deki ice aktar (import button) butonuna basilarak

aktarma islemi yapilmaktadir (Sekil 3.17).

<
Imgon Unity Package
AR_images
* Rt

v o itrla
¥ o i InimgsTorget tastins
v

3
i
it

* Mg Strvamaghasens
v E Vulwein
5 = AR images,dat
o mages s

EE

-

T [Cancel]

Y

Sekil 3.17. Veri tabanini ige aktarma

Ardindan, sahneye Vuforia Engine hedeflerini eklemek icin GameObject>Vuforia
mentisiinde iligkili Oyun Nesneleri segilir. Sahne hiyerarsisinde bir hedef "Oyun Nesnesi"
olarak eklenmekte ve sahnede goriinmektedir (Sekil 3.18). Her hedef nesne
yapilandirilmaktadir. Bu adimdan sonra goriintii hedefi, sahnede goriintiilenmektedir (Sekil

3.19).
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< Unity 2019.2 AR Test Prject - SampleScene - Android - Unity 2019.2.12f1 Personal* <DX11>
File Edit Assets GameObject Component Window Help

m = B Create Empty Ctrl+Shift+N
“= Hierarchy Create Empty Child Alt+Shift+N
Create = (Grall 3D Object >

SampleSc 2D Object N
_ Direction

Effects >
Light >
Audio >
Video >
Ul >

\{ ) AR Camera
Camera I ) age
Center On Children Multi Image
Make Parent Cylindrical Image
Clear Parent Cloud image ’
Camera Image >
; i Chrle=
Set as first s»nbl.mg Ctrl+= Model Target
Set as last sibling Ctrl+- 3D Scan
= . Move To View Ctrl+Alt+F
@3 Project 'E;‘ i VuMark
Align With View Ctrl+Shift+F
' ' Align View to Selected Ground Plane 2
Toggle Active State Alt+Shift+ A S e 2

Sekil 3.18. Sahneye goriintii hedefleri ekleme

File Edid Assety GameCbect Componemt  Window Help

Soscenedtryd

Sekil 3.19. Eklenen goriintii hedefi

e Dijital Varliklar Ekleme

Goriintli hedefini artirmak i¢in dijital igerik eklenmesi gerekmektedir. Bu, sadece sahne

hiyerarsisinde hedefin alt 6gesi olarak dijital varliklar eklenerek yapilmaktadir.
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Ornegin eviren amplifikatoriin giris ve ¢ikis sinyalleri dijital icerik olarak kullanilacaktir. Gerekli

sinyaller MATLAB fizerinde asagidaki kod kullanilarak ¢izilmistir.

clear all; clc;
£f=50; rl1=10; r2=20; vim=5; vcc=15;
t=linspace(0,1/f,256); wt=2*pi*f*t; vi=vim*sin (wt);
for 1i=1:256
vo(i)=-(r2/rl)*vi(i);
if vo (i)>vcc
vo (i) =vcc;
end
if vo(i)<-vcc
vo (1)=-vcc;
end
end
subplot (211); plot(t,vi,'b', 'LineWidth',2); axis ([0 1/f -10 101);
grid on; xlabel('Time (s)'"); ylabel ('Amplitude (V)');
subplot (212); plot(t,vo,'r', 'LineWidth',2); axis ([0 1/f -20 201);
grid on;xlabel ('Time (s)'); ylabel ('Amplitude (V) ');

Ayni giris isareti i¢in farkli diren¢ degerlerinde, dogal olarak farkli ¢ikis isaretleri olusacaktir
(Sekil 3.20).

E \\\\\\‘—J///////////'_‘\\\\\ g‘ S\\________//////—_______\\\

1018 X
& D018 04
e (8]

Sekil 3.20. a) ilk sinyal; R1 = 10kQ, R2 =20kQ. b) ikinci Sinyal; R1 = 10kQ, R2 = 50kQ.

Giris ve ¢ikis sinyallerini goriintii hedefinin alt 6geleri olarak eklenmektedir. Bunu yapmak igin,
gorlintii hedefinin alt 6geleri olarak sahne hiyerarsisinde bir dortlii (Quad) olusturulmaktadir
(Sekil 3.21). Ondan sonra, varliklar dosyasinda (assets file) yeni bir malzeme olusturulmakta,
olusturulan yeni malzemeye giris ve ¢ikis isareti resimlerini eklenmekte ve bu malzemeyi
dortliige siiriiklenip birakilmaktadir (Sekil 3.22). Eklenen dijital igerikler art arda sinyall ve

sinyal2 olarak adlandirilmistir.
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@ v € SsampleScene*
' Directional Light
~ ARCamera

Paste

Rename

Duplicate
Delete

Select Children
Select Prefab Root

Create Empty

3D iject > Cube
2D Object > Sphere
Effects > Capsule
@ Project I Light > Cylinder
| Create ~ ) Audio > Plane
VE ?Eavorltt 3 ey
3 Vid > i
©LAll Maf 105 Quad
@All Mo: ul > Text - TextMeshPro —
@1“" Pre Vuforia Engine > Ragdoll... -
Camera Terrain .
» & Animation 3t Tree Materials
i Ed!@r o Wind Zone
» & Fonts. —_—
& Materials 3D Text )
» (& Models |

Sekil 3.21. Sahneye bir dortlii ekleme

= rhararchy

Sekil 3.22. Sahneye dijital icerik ekleme

e Mobil cihaz i¢in kullanici arayiizii olusturma

Ilk olarak, UI Unity Ornekleri Unity icindeki varlik deposundan (asset store) ice
aktarilmaktadir. Ardindan, sahne hiyerarsisinde sol fare tusuna basilarak sahneye panel

eklenmektedir (Sekil 3.23).
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File Edit Assets GameObject Component Window Help

¥ + EIEAIIOIES

= Hierarchy # Scene Gam set St
Create *| (@Al ) || | shaded |20 || ® |
v €} SampleScene =
| Directional Light
| |ARCamera
|/ ImageTarget Text
Copy Text - TextMeshPro
Paste Image
Renaie Raw Image
Duplicate Batton
Delete Button - TextMeshPro
Toggle
Select Children Slider
Select Prefab Root Scrollbar
Create Empty Dropdown
3D Object > Dropdown - TextMeshPro
2D Object > Input Field
@ Project Effects > Input Field - TextMeshPro
L‘E’_‘:ﬂl__ Light > Canvas
FESAND Ao > Panel
» (5 Editc . =
» &5 Font Video > Scroll View
ﬁMﬂt& i J > Event System
= g :::: Vuforia Engine > F

Sekil 3.23. Sahneye bir panel ekleme

Ice aktarilan UI Unity 6rneklerinden, SF penceresini denetgi penceresindeki panelin kaynak

goriintiisline eklenmektedir (Sekil 3.24).

IninTire
Hicensr &
Paals Pay Lns Ml 1
Defaut Ul Matenal e

e e
kv Qmw;.!zwnﬁew-mv SF Ut

e | — DU—’

Sekil 3.24. SF penceresini ekleme

Olusturulan panele bir resim eklemek i¢in ilk panelde farenin sol tusuna basilarak UI

mentiisti>resim segilmektedir (Sekil 3.25).
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Sekil 3.25. ilk panele goriintii ekleme

Eklenen goriintiiniin boyutunu istenildigi gibi ayarlanmakta ve SF penceresinde yer alan
denetcideki goriintii kaynagina tekrar eklenmektedir. Ayni sekilde Ul meniisii>Metin
secilerek goriintilye metin eklenmektedir (Sekil 3.26).

Select Onldren

Selnct Pretab Rock Scroiibar

Creste Empty Dropdown

3D Object Dropdown - TextMeshPro
20 Object fegut Field

Input Field - TextMeshPro

Panel
Scroll View
Everd System

v ¥y vov v v

Sekil 3.26. ilk panele metin ekleme
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Denetci penceresindeki metnin boyutu ve konumu ayarlanabilmektedir. Sekil 3.27'de Metin

yuvasina (Text slot) “Scan Marker” yazilip font ayarlarinin yapilmasi goriilmektedir.

o inspector | a-=
- e
Tag | Untagged +| Layer | UI ] |
‘l' Rect Transform @ 5 % -
center Pos X Pos Pos 2
w 0 0 0
e AEE— Width  Height
E 200 50 | R
» Anchors
Pivot %05 v[05
Rotation ®0 ¥ 0 Z0
Scale i1 ¥l Z|1
¥(@ Ccanwvas Renderer @ = %
Cull Transparent Mes_|
¥ ¥ Text (Script) Q@ =
Text
o

Scan Marker

Character

Fant A Arial o]

Font Style | Bold &

Fant Size 30

Line Spacing 1

Rich Text [+ L

Sekil 3.27. Eklenen metni ayarlama

Boylece ilk panel Sekil 3.28°de goriildiigii gibi hazir olmaktadir.

KT B hesal Biue — %
ol Brake L Gimas

Fras Aeguct e s Maxwuiie O6 Play | Mues Asdie Wijpas | Soies

Sekil 3.28. 1lk panel
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Daha sonra, sahne hiyerarsisine baska paneller eklenmektedir. Bunlar; goriintii, hedefi

izlendikten sonra kullanicinin etkilesime girecegi arayiiz olarak kullanilacaklardir.

[k panelin hedef olmadiginda gériinmesini saglamak ve hedef izlendiginde kaybolmasi igin
bir kod eklenmektedir. Bunu yapmak ig¢in, sahne hiyerarsisinde goriintii hedefini segerek
denetgi penceresinden "Default trackable event handler" dosyasini agilmaktadir ve iizerinde
asagidaki gibi birka¢ degisiklik yapilmaktadir. Birinci olarak, ilk panelin tanimlanmasi
gerekmektedir. Ardindan, paneli asagidaki gibi dogru sirayla géstermek i¢in hem bulunan
izlemeye (on tracking found) hem de kayip islevleri izlemeye (on tracking lost) kod
eklenmektedir.

using UnityEngine;
using Vuforia;

public class DefaultTrackableEventHandler : MonoBehaviour, ITrackableEventHandler
{
region PROTECTED MEMBER VARIABLES

protected TrackableBehaviour mTrackableBehaviour;
protected TrackableBehaviour.Status m PreviousStatus;
protected TrackableBehaviour.Status m NewStatus;
public Transform firstpanel;

#endregion // PROTECTED MEMBER VARIABLES

ffregion UNITY MONOBEHAVIOUR METHODS

protected virtual void Start()
{
mTrackableBehaviour = GetComponent<TrackableBehaviour>();
if (mTrackableBehaviour)
mTrackableBehaviour.RegisterTrackableEventHandler (this);

}

protected virtual void OnDestroy ()
{
if (mTrackableBehaviour)
mTrackableBehaviour.UnregisterTrackableEventHandler (this) ;

}
ffregion PUBLIC METHODS

public void OnTrackableStateChanged (
TrackableBehaviour.Status previousStatus,
TrackableBehaviour.Status newStatus)

m PreviousStatus = previousStatus;
m NewStatus = newStatus;

Debug.Log ("Trackable " + mTrackableBehaviour.TrackableName +
" " + mTrackableBehaviour.CurrentStatus +
" —-— " + mTrackableBehaviour.CurrentStatusInfo);
if (newStatus == TrackableBehaviour.Status.DETECTED | |
newStatus == TrackableBehaviour.Status.TRACKED | |
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newStatus == TrackableBehaviour.Status.EXTENDED TRACKED)

OnTrackingFound () ;
}
else 1if (previousStatus == TrackableBehaviour.Status.TRACKED &&
newStatus == TrackableBehaviour.Status.NO POSE)
{
OnTrackingLost () ;
}
else
{
OnTrackingLost () ;

}

#endregion // PUBLIC METHODS
#region PROTECTED METHODS

protected virtual void OnTrackingFound/()
{

if (mTrackableBehaviour)

{

var rendererComponents =
mTrackableBehaviour.GetComponentsInChildren<Renderer> (true) ;
var colliderComponents =

mTrackableBehaviour.GetComponentsInChildren<Collider> (true);

var canvasComponents =
mTrackableBehaviour.GetComponentsInChildren<Canvas> (true) ;

// Enable rendering:
foreach (var component in rendererComponents)
component.enabled = true;

// Enable colliders:
foreach (var component in colliderComponents)
component.enabled = true;

// Enable canvas':
foreach (var component in canvasComponents)
component.enabled = true;

}
firstpanel.gameObject.SetActive (false) ;

protected virtual void OnTrackingLost ()
{
if (mTrackableBehaviour)
{
var rendererComponents =
mTrackableBehaviour.GetComponentsInChildren<Renderer> (true);
var colliderComponents =
mTrackableBehaviour.GetComponentsInChildren<Collider> (true);
var canvasComponents =
mTrackableBehaviour.GetComponentsInChildren<Canvas> (true) ;

// Disable rendering:
foreach (var component in rendererComponents)

component.enabled = false;
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// Disable colliders:
foreach (var component in colliderComponents)
component.enabled = false;

// Disable canvas':
foreach (var component in canvasComponents)
component.enabled = false;

}
firstpanel.gameObject.SetActive (true) ;

}

#endregion // PROTECTED METHODS

e Bir agilir liste olusturma

Ornegin goriintii hedefi olarak kullanilan eviren yiikselte¢ devresi iki direnc icermektedir.
Kullanicinin bu direnglerin degerlerini segebilmesini saglamak i¢in bir acilir meni
olusturulmasi gerekmektedir. Bunun i¢in UI>Dropdown menii secenegi tiklanarak ikinci
panelin alt 6geleri olarak bir agilir liste olusturulmast Sekil 3.29'da goriilmektedir. Direng

degerleri ise denet¢i penceresinden girilmektedir (Sekil 3.30).

v < leScenes*
_ ARCamera
¥ ImageTarget
_ wgnall
- st
¥ Canvas
Afirstpanel

Test

/ EventSystem Text - TextMezhPro
Paste image
Rename Raw image
Duplicate Buttan
Button - TextMeshPro
Delete
Teggle
Shder
Scrolibar
Create Empty Dropdown
Craata ~ B A0t Dropdown - TetMeshPro
 Favorites & Ay 20 Object > Input Freld
L All Materials EMects : i Tt AP
 All Models
Al Prefabs Light > Canves
Audio 3 Pane
> i Animation j  Video > Scrofl View
» g Editor u » Event System
> .. hﬂl g Vufons Engine >
= by I Camera
* S Modely

Sekil 3.29. Bir agilir liste olusturmak
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& Inspector ]

| Visualize
Template Template (Rect Transform| @
Caption Text Label (Text) @
Caption Image Mone (Image) o]
Itemn Text Itemn Label (Text) @
Item Image Mone (Image) @

Value 0
Alpha Fade Speed |0.15

Options

— |Please choose the value of the resistars

Mone (Sprite) o]
= |[R1=10kQ, RZ=20kQ

Mone [(Sprite) o]
= [R1=10kQ, RZ=50kQ

Mone (Sprite) ]

Sekil 3.30. Direnclerin degerlerini eklemek

Sahne oynatildiktan sonra tasarlanan agilir liste Sekil 3.31'deki gibi goriinecektir.

Maximize On Play | Mute Audio | VSync |Stats Gizmos ' ¥

Please choose resistor values

v Please choose resistor values
R1=10kQ). R2=20kQ
R1=10kQ. R2=50kQ

Sekil 3.31. Acilir liste
Son adim olarak ise kullanict listedeki ilk secenegi sectiginde, ilk grafik (sinyal 1) ve ikinci
secenegi sectiginde ikinci grafik (sinyal2) goriinmesinin saglanmasi gerekmektedir. Bunun i¢in

ilgili kod asagidadir.
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using System.Collections;

using System.Collections.Generic;
using UnityEngine;

using UnityEngine.UI;

public class dropdownexample : MonoBehaviour
{

public Dropdown dropdown;

public GameObject signall;

public GameObject signal2;

void Start ()

{
signall.SetActive(false);
signal2.SetActive (false);

}
public void Dropdown IndexChanged (int index)
{

if (index==1)
{
signall.SetActive (true);
signal2.SetActive (false);
}
else if (index==2)
{
signal2.SetActive (true);
signall.SetActive (false);
}
else
{
signal2.SetActive (false);
signall.SetActive (false);

Sahne hiyerarsisinde sag tiklanarak bos olustur (create empty) segilmekte, sahne denetleyicisi
(scene controller) olarak adlandirilmakta ve dropdownexample komut dosyasi, sahne
denetleyicisine tasinip birakilmaktadir. Sahne denetleyicisi, denetci penceresinde bir acgilir liste,
sinyall ve sinyal2 nesneleri arayacaktir. Bunun i¢in nesneler, sahne hiyerarsisinden siiriiklenip

yuvalara birakilmaktadir (Sekil 3.32).
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8 Inspector

| ,J ¥ |scenecontraller | ] statie
-
Tag [ Untagged t] Layer | Default

¥ .~ Transform 2
Position ¥ 3845 |Y 1635 |Z 0
Rotation X0 [¥ |0 [Z 0
Scale X1 [¥ |1 [z 1

¥ « ¥ Dropdownexample (Script) @ =
Script dropdownexample
Dropdown |[*|Dropdown (Dropdown) |
Signal 1 | Isignall |
Signal 2 |l,_.lsigna|2 |

add Component ]

Sekil 3.32. Inspector penceresinde sinyall, sinyal2 ve acilir listeyi tanimlama

Acilir denetleyici penceresinden sahne denetleyicisi olay isleyicisini (scene controller event

handler) segerek kullanilan sinif belirtilmektedir (Sekil 3.33-3.34).

= Please choose resistor values =1

Select Object nl ~ |None (Sprite) 1e

(@5 | = [R1=10kQ, RZ=20kQ )
Assets Scene — None (Sprite) 1o

41— [R1=10kQ, RZ=50kQ |

‘None (Sprite) | o

<

" on Value C‘hanged4 (Int32)
firstpanel scenecontr., Scrollbar -

Runtime Only # || Mo Function

’
+ —-—
™ ) s Default UI Material @ =
‘secondpanel signall signal2

| > Shader | Ul/Default B

’ [ Add Component ]

scenecontroller
‘Game Object

Sekil 3.33. Sahne denetleyicisi olay isleyicisini segcme
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e MNone [(lmage) .

Dynamic int
0

0.15

Dropdown_IndexChanged

Static Parameters

bool enabled resistor values

string name [}
bool runinEditMade =20k
string tag ©
bool useGUILayout =50k 5
BroadcastMessage (string) +
Cancellnvoke (string)
Cancellnvoke () pd (Int32)
Dropdown_IndexChanged (int) LRI d
SendMessage (string) IRl anisn
SendMessagelpwards (string) GameObject ¥
StopAllCoroutines () Transform o
StopCoroutine (string) dropdownexample >

i

Sekil 3.34. Kullanilacak sinifi belirtme

e Devrelerin 3B modellerini olusturma.

Gergeklestirilen calismada devrelerin 3B modellerini olusturmak i¢in 3ds Max kullanilmistir. 3ds
Max, 3D animasyonlar, modeller, oyunlar ve goriintiiler yapmak i¢in profesyonel bir 3D
bilgisayar grafik programidir. 3ds Max, verimli bir is akis1 ve gii¢clii modelleme araglariyla oyun
sanat¢ilarina énemli dlgiide zaman kazandirabilir. En popiiler programlardan biridir ve 3ds Max

modelleme s6z konusu oldugunda hiz ve basitlikte essizdir (Petty 2020).

Ornegin eviren yiikselteg devresinin 3D modelini olusturmak igin izlenen adimlar asagida

Ozetlenmektedir:

» Ana kart1 olusturma (Sekil 3.35)
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Sekil 3.35. Ana kart olusturma

Tahtaya doku ekleme (Sekil 3.36)

Sekil 3.36. Tahtaya doku ekleme
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» Cizim panelini hazirlanmasi (Sekil 3.37)

7 igaratnl
kaldiedmistir

10 Fotograf
Birakmak

Sekil 3.37. Cizim Panelinin Hazirlanmasi

= Direncin kenar ¢izimi (Sekil 3.38)

Sekil 3.38. Direncin kenarmin ¢izilmesi
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» Cizimden model olusturma (Sekil 3.39)

5 X ekseninde
| haroket otme

Sekil 3.39. Cizimden model olusturma
» Malzemeyi olusturma (Sekil 3.40)

8 |zaratini kakdnimigtr

“r» --' ‘;. +

a) Malzemeyi olusturmak
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1 Isaretini kakdinimists

P 4+5 Tekrarlamak

c) Direncinin renkleri olusturmak
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[——4
IOES - Mwede

Sveniden Lo " |

B Adlandmimigtr

7 Yenceﬁ
Adtandinimigtir

e) Ikinci direncin renklerini olusturmak

Sekil 3.40. Malzemenin olusturulmasi
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= Direng bacaklar1 olusturma (Sekil 3.41)

9 Cizime Baglamak

6 Isaratlenmistir
7 X Exseninde |

Hareket Etme |

b) Direncin diger telini/bacagini olusturma

Sekil 3.41. Direng telleri/bacaklarini olusturma
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= Direnci klonlamak (Sekil 3.42)

2 Yeniden Adlanginimagtir

l - 3 Tokrarlamak

Sekil 3.42. Direnci klonlama
= IC'yi olusturulma (Sekil 3.43)

Sekil 3.43. IC'yi olusturma
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= [IC bacaklarin1 modelleme (Sekil 3.44)

Sonug, Kutuyu Manual olarak IC yuzeyine
hizalnmistir

2 Mesh'| Duzenie (Edit Mesh)
Aranmighr

4 Al Nesna Araclarn

b) Alt nesne araglari kullanarak kutuyu modellemek
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8Y akseninde hareket
“ime

X ekseninde Hizalama

d) IC bacaklarina ayna eklemek
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2 Mesh' Duzenle (Eoa
Mesh) Aranmeghr

3 Alt Nesne Arac

4 Y ekseninde Hizalama

f) IC bacaklarini ayni sekilde diger tarafta olusturmak

Sekil 3.44. IC bacaklarinin modellenmesi
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= IC pargalar1 gruplama (Sekil 3.45)

Sekil 3.45. IC parcalarini gruplama
= Kablolari olusturma (Sekil 3.46)

a) Breadboard iizerinde tel olusturmak
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> R
3 Uzunh Degenm
K.ayded_il.nugm
~

b) Tel uzunluk degerini kaydetmek

Sekil 3.46. Kablo olusturma
= Kablo blendaj kapagini olusturma (Sekil 3.47)

a) Kapsiil nesnesi olusturma
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b) Tel blendajinin tam olarak tellerin {izerine yerlestirilmesi

Sekil 3.47. Tel kalkan kapag1 olusturma

Geri kalan kablolarin olusturulup breadboard {izerine yerlestirilmesi (Sekil 3.48)

Sekil 3.48. Diger kablolar1 olusturma
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Tiim modellerin yerine koyulmasi (Sekil 3.49)

Sekil 3.49. Modelleri yerinde yerlestirmek

Metinlerin olusturulmasi (Sekil 3.50)

Sekil 3.50. Metin olusturma
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¢ 3B modeli Unity’ye ekleme.

3B modeli Sekil 3.51'de gosterildigi gibi Unity’ye aktarilmaktadir.

< Unity 2019.2 AR Test Prject - scene2 - Android - Unity 2019.2.12f1 Personal <DX11>
File Edit Assets GameObject Component Window Help
Create

Show in Explorer
Open
Delete

= Hierarch

Rename
Copy Path Alt+Ctrl+C

Open Scene Additive

Import Package > b ooos coos ool
Export Package...
Find References In Scene

Select Dependencies

Refresh Ctrl+R R

Reimport

Reimport All
Extract From Prefab

Run API Updater..,

‘ Update UlElements Schema

Sekil 3.51. 3B modeli Unity’ye aktarmak

Breadboard'un bir kopyasini Unity i¢inde referans olarak kullanarak 3d model devresi, yerine
tam olarak konumlandirilmalidir (Sekil 3.52).
€ Uniny 20132 AR Test Prject - scanes - Andvend + Unity 201521291 Pessenal® <DX11»

Foe Edt Assets GameOtyect Compovent  Window Help
ORENS 2IEL LK eeve | $tocwl |

pifidt

ng

i

it

Sekil 3.52. 3B modeli breadboard iizerinde dogru bir sekilde yerlestirmek
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e  Unity i¢inde butonlar olusturma

Islemler i¢in Unity programinda 3B devre modeli igin bir buton olusturulmas: gerekmektedir.
Bunun i¢in "3B model" olarak adlandirilan buton, ikinci panelin alt 68esi olarak eklenmelidir

(Sekil 3.53).

g Unity 2019.2 AR Test Prject - scene2 - Android - Unity 2019.2.12f1 Personal <DX11>
File Edit Assets GameObject Component Window Help

m + EIEAIEOIEA mm

= Hierarchy = #Scene
lCrean S|l @Al ||| shaded
% v & scene2 =
U Directional Light
| |ARCamera
U:cenacontmller

(g Qu!d

Amplitude (V

» U Imaqe rget
v L;,d Cany
>l ﬁr:tpanel ' "l
W@ secondpanel ) Text L~
~ | Dropdown Copy Text - TextMeshPro t
W Paste Image
Rename Ralw lf\age
Duplicate alon B
Delete Button - TextMeshPro
Toggle
Select Children Slider
Select Prefab Root Scrollbar
Create Empty Dropdown
3D Object > Dropdown - TextMeshPro |
2D Object > Input Field A5
Effects > Input Field - TextMeshPro -
Light > Canvas
Audio > Panel :
Video > Scroll View
= 780 ..
ur R4 Event System =
Vuforia Engine
Camera

—[ '—mmaa

Sekil 3.53. Buton ekleme

[lave edilen butona ait komut dosyas1 (script) asagida verilmektedir.

using System.Collections;
using System.Collections.Generic;
using UnityEngine;

public class openmodel : MonoBehaviour

{
public GameObject Circuit3d;

public void openCircuit3d()
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if (Circuit3d != null)

bool isActive = Circuit3d.activeSelf;
Circuit3d.SetActive (!isActive);

3B model devresi breadboard'un {istiinde goriinmesini saglamak igin ikinci bir buton
eklenmelidir. Ayni sekilde {igiinci ve dordiincii butonlarla da ilgili devrenin giris-¢ikis
bagintisinin ve konu anlatiminin goériinmesi saglanacaktir.

Son olarak asagidaki adimlar izlenerek uygulama hazir hale getirilmektedir.

e Oynatici ayarlarindan, yon yatay sol (Landscape left) olarak secilmistir, "use 32 bit
display buffer" isareti kaldirilip, bunun yerine " disable depth and stencil " isaretlenmistir.

e Sahne c¢ubugunun yanindaki Oyun ¢ubuguna basilmis ve ¢Oziiniirlik en boy oranim
(aspect ratio) 16:9 Yatay olarak ayarlanmistir.

e Tuval denetgisi (inspector window) penceresinden UI Olgekli Modeli (Ul Scale Model)
"Scale with Screen Size" olarak yerlestirilmistir.

e Dosya> Yap1 Ayarlarr> Olustur'a basilmistir.

Yukarida adimlarda 6rnek olarak eviren yiikselte¢ devresi gosterilmistir. Benzer adimlar diger
devreler icin tekrarlanmaktadir. Bu devreler Tablo 3.1'de verilmektedir.

Tablo 3.1. Kullanilan yiikselte¢ devreleri

Turi Devre semasi Giris-cikis bagintisi
Eviren
—ANWY
R
—AMA— |l VO = — (R_{> * Vl
Evirmeyen
AW~
_L— AW _\_\\ R f ]
= v V0=<1+—>*Vl
-— 4_’// R]-
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Toplama

R R
Vout = —( f V1_|__f

— %
R1 R2

* VZ)

Cikarma

Vout Vl(m3+vz
= — * —
ou R1

<R4
% | ————
2+ R4
1+R3

R R)
(57

Integral

Vout = —

1 t
Vin dt
RmCL m

Tirev

> Voul

—o

Vout = — Rf.C

dVin
dt




4. BULGULAR VE TARTISMA
4.1. Uygulamalar

Geligtirilen AG uygulamasmin testi, Huawei NMO-L31 marka akilli telefonda
gergeklestirilmistir. Uygulamanin ana arayiizii Sekil 4.1'de goriilmektedir.

Scan Marker

Sekil 4.1. Uygulamanin ana arayiizii

e Eviren Yiikselteg

Bir eviren ylikselteg, girisi bir R1 direnci iizerinden eviren terminalden alir ve ¢ikis olarak
kuvvetlendirilmis versiyonunu iretir. Bu yiikselte¢ sadece girisi giiglendirmekle kalmaz, ayni
zamanda onu tersine ¢evirir (isaretini/fazin1 degistirir) (Electronicsnotes 2020).

Bir eviren yiikseltecin devre semasi, Sekil 4.2'de verilmektedir.
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Ry

0-Vi 0-V0
Rl T Rf 0 (4.1)
—Vi V0
T (4.2)
Vo= — (g—]lc) x Vi (4.3)

Cikis gerilimi V0 ve girig gerilimi Vi'nin orani, yiikseltecin gerilim kazanci veya kazancidir. Bu

. , . R o
nedenle, eviren yiikseltecin kazanci — R—’: 'e esittir.

Eviren yiikseltecin kazanci negatif bir igarete sahiptir. Bu da giris ve ¢ikis arasinda 180° faz farki
oldugunu gostermektedir. Eviren yiikseltecin kullanim alanlar1 (Electronicsnotes 2020):

e Eviren yiikselteg, voltaj toplayict veya toplama yiikselteci i¢in tam kullanilir.
e Eviren yiikseltecin, 6lgeklenen toplama yiikselteci i¢in uygundur.
e Dengeli yiikselteg i¢in gegerlidir.

Buna gore farkli direng degerleriyle eviren yiikselte¢ uygulamalar1 sirasiyla Sekil 4.3-4.4'te

verilmektedir. 3D, Vout ve Konu anlatimi butonlarina tiklanildiginda/basildiginda olusan

gortintiiler de sirasiyla Sekil 4.5-4.7'de goriilmektedir.
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R1=10K0,R2=20K0 v

Sekil 4.3. R1 = 10KQ, R2 = 20KQ ile giris ve ¢ikis sinyalleri

R1=10K0,R2=50K0 v

Sekil 4.4. R1 = 10KQ, R2 = 50KQ ile giris ve ¢ikis sinyalleri
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Please select resistance values \

Sekil 4.6. Eviren yiikselte¢ devresinin girig-¢ikis bagintist
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AN Invertng ampliner takes the input

tnrougn Its inverung terminal througn a
resistor R1, ana proauces Its amplined
VErsion as the output. 1 nis ain’,JHi'lt:‘i Mot
Only aiupal?lcs tne Input dbut aiso Inverts It
(Changes IS sign).

SAN e O;;l. L CEL “Een “r s L LR L

Dloi

Sekil 4.7. Eviren yiikseltecin agiklamasi

e Evirmeyen Yiikselteg

Evirmeyen bir yiikselteg, girisi evirmeyen terminalinden alir ve ¢ikis olarak kuvvetlendirilmis
versiyonunu {iretir. Adindan da anlagilacagi gibi, bu yiikselteg, ¢ikisin isaretini tersine
cevirmeden veya degistirmeden girisi giiclendirmektedir (Electronicsnotes 2020).

Evirmeyen yiikseltecin devre semasi Sekil 4.8'de verilmektedir.

R¢
A\

Ry

T

Sekil 4.8. Evirmeyen yiikseltecin devre semasi
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Sekil 4.8 gosterilen devrede, giris gerilimi Vi dogrudan op-amp'in evirmeyen giris terminaline

uygulanmaktadir. Béylece, op-amp'in evirmeyen giris terminalindeki gerilimi Vi olacaktir.

Gerilim bolme prensibini kullanarak, op-amp'in eviren giris terminalindeki gerilimi (V1) Esitlik
(4.4)'te verilmektedir.

V1="V0x* (ﬁ) (4.4)

Bir op-amp'in eviren giris terminalindeki gerilimi, evirmeyen giris terminalindeki gerilimle
aynidir.

V1i="Vi (4.5)

Vo ( K1 ) Vi 4.6
X | —m—m | =

RL+Rf) " (46)

Vo Rl 47

Vi R1+Rf (“7)
Vo Rf

i il 4.8

Vi TR (4.8)
Rf

= — [ 4.9

Vo (1+R1>*Vl (4.9)

Boylece ¢ikis gerilimi V0 ve giris gerilimi Vi oran1 veya evirmeyen yiikseltecin voltaj kazanci
Rf ,

14+ —'e esittir.
R1
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Evirmeyen yiikseltecin kazanci, pozitif bir isarete sahiptir. Giris ve ¢ikis arasinda faz farki
olmadigini gosterir. Op evirmeyen devrenin empedansi 6zellikle yiiksektir. Bu islemsel yiikselteg
devresinin giris empedans: tipik olarak 10’ Q 'un ¢ok iizerinde olabilir. Cogu devre uygulamasi
icin, devrenin Onceki asamalar {izerindeki herhangi bir yiikleme etkisi, asir1 derecede hassas
olmadiklart siirece, ¢ok yiiksek oldugu i¢in tamamen goz ardi edilebilir.

Evirmeyen yiikseltecin kullanim alanlar1 (Electronicsnotes 2020):

e Evirmeyen bir yiikselteg, gerilim boliicii negatif geri besleme baglantisi kullanir.
e Gerilim kazanci her zaman 1'den biiyiiktiir.

Buna gore farkli direng degerleriyle evirmeyen yiikselte¢ uygulamalar sirasiyla Sekil 4.9-4.10'te
verilmektedir. 3D, Vout ve Konu anlatimi1 butonlarina tiklanildiginda olusan goriintiiler de

sirastyla Sekil 4.11-4.13'te goriilmektedir.

Sekil 4.9. R1 = 100K, R2 = 500KQ ile giris ve ¢ikis sinyalleri

74



R1=50K(,R2=500KQ v

Sekil 4.10. R1 = 50KQ, R2 = 500KQ ile giris ve ¢ikis sinyalleri

Sekil 4.11. Evirmeyen yiikselte¢ devresinin 3D modeli
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Sekil 4.12. Evirmeyen yiikselte¢ devresinin giris-¢ikis bagintisi

A non-inverting amplifier takes the input
throughn Its non-inverting terminal, anad
proauces Its ampliriea version as tne
output. As the name suggests, this

amplifier just amplifies the input, without

Inverting or changing the sign of the

OULPUL.

e

Sekil 4.13. Evirmeyen ylikseltecin agiklamasi
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e Toplama Yiikselteci

Toplama yiikselteci, sinyalleri birlestirmek i¢in kullanilan ¢ok yonlii bir cihazdir. Sekil 4.14'teki
devre, her biri sabit kazang¢ faktorii ile carpilan gerilimleri cebirsel olarak toplamaktadir

(eklemektedir) (Solid Fluid System Solutions 2020).

Iy
I;
Vi@ - y

AAA I A v A -“‘ v
\ I: A
4 s + Yo
4
fitoal aart Vs
i °

Sekil 4.14. Toplama yiikseltecin devre semasi

11_V1

T R1

12—V2

" R2

If=I11+12

Rf Rf

= —[—=—*xV1+ —==xV2
Vout (Rl*V +R2*V>

Toplama yiikseltecinin kullanim alanlart:

(4.10)

(4.11)

(4.12)

(4.13)

o Giriste farkli direnglere sahip bir toplama yiikselteg, agirlikli bir toplam verir. Bu, ikili bir
sayiy1 (Binary number) dijitalden analoga doniistiiriiciide gerilime doniistirmek igin

kullanilabilir (Wikipedia 2020).

e Bir toplama yiikselteci, iki veya daha fazla sinyalin eklenmesi veya birlestirilmesi
gerektiginde, ses karistirma (audio mixing) uygulamalarinda oldugu gibi yararli bir

devredir (Wikipedia 2020).
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Buna gore farkli direng degerleriyle toplama yiikselte¢ uygulamalari sirasiyla Sekil 4.15-
4.16'te verilmektedir. 3D, Vout ve Konu anlatimi butonlarina tiklanildiginda olusan
goriintiiler de sirastyla Sekil 4.17-4.18-4.19'de goriilmektedir.

Sekil 4.15. R1 =500KQ, R2 = 1000KQ, Rf = 1000KQ ile giris ve ¢ikis sinyalleri

Sekil 4.16. R1 = 500KQ, R2 = 100KQ, Rf = 1000KQ ile giris ve ¢ikis sinyalleri
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Sekil 4.18. Toplama yiikselte¢ devresinin girig-gikis bagintisi
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in e nverung operatornal ampuner e inverung
alnpiuner nas a singie lll}:UL voltage, (Vi) applied
0 UIE .wug:adixu* il.-,;u; ierminal. i Hole H‘.‘,,-ut
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7 \ /

operatonal almputiel CIrCuit called a SUITHTNg
Ampilmer, summiming mverier Oor even a voitage

adder will pe crealed.

Dioi

Sekil 4.19. Toplama ytikseltecin agiklamasi
e (ikarma Yiikselteg

Standart bir iglemsel yiikseltecin iki girisi oldugu i¢in sinyaller, bu girislerin her ikisine ayni
anda baglanabilir ve ¢ikarma (fark) yiikselteci olarak adlandirilan yapi olusturulabilir. Temel
olarak, bir giris terminaline bir gerilim sinyali ve diger giris terminaline bagka bir gerilim sinyali
baglanarak ortaya ¢ikan ¢ikis gerilimi, bu girislerin farkiyla orantili olacaktir (Sekil 4.20) (Solid
Fluid System Solutions 2020).

L R3
——AAN—
I R1
1 V
Vi o——ANN
I R2 V. B
V: 0o AAN——1 4

{
Qv
o e o

Sekil 4.20. Cikarma yiikseltecin devre semast

Vout ¢ikis gerilimi bulmak i¢in Siiperpozisyon yontemi kullanilabilir.
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_ Vl—-Va

11
R1

_V2-Vb

12
R2

_ Va — Vout

7 R3

Va=Vb

Vb =1V2 ( ka )
= * | —————

R2 + R4
Eger V2 = 0 ise:

(@) 1 (RS)
% — V1 —
outla 1

Eger V1 = 0 ise:

R4 )*<R1+R3)

Vout(b) = V2« (RZ R4 R1

Vout = —Vout(a) + Vout(b)

Vout = —V1*(§)+V2*( R4 )*(R1+R3)

R2+R4 R1

(4.14)

(4.15)

(4.16)

(4.17)

(4.18)

(4.19)

(4.20)

(4.21)

(4.22)

Direngler, R1 = R2 ve R3 = R4 oldugunda, ¢ikarma yiikselte¢ icin yukaridaki transfer

fonksiyonu asagidaki ifadeyle basitlestirilebilir:
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R3
Vout = T V2-V1) (4.23)

Cikarma (fark) yiikseltecin kullanim alanlart:

e Fark (diferansiyel) yiikselteg, hem eviren hem de evirmeyen yiikselteclerin bir
kombinasyonudur. Fark gerilim kazancini kontrol etmek icin negatif geri besleme
baglantis1 kullanir (Wikipedia 2020).

e (ikarma yiikselteg, otomatik kazang kontrol veya ses kontrol devresi olarak kullanilabilir
(Wikipedia 2020).

e Bazi ¢ikarma yiikseltegler, genlik modiilasyonu i¢in kullanilabilir (Wikipedia 2020).

Buna gore farkli direng degerleriyle ¢ikarma yiikselte¢ uygulamalar: sirasiyla Sekil 4.21-4.22'te
verilmektedir. 3D, 3D, Vout ve Konu anlatimi1 butonlarina tiklanildiginda olusan goriintiiler de
sirastyla Sekil 4.23-4.25'de goriilmektedir.

.9?3‘:’- .

H
€
o
<
1]
A

IL.CO.Q.

. e b
-

-

-.

Dioi

Sekil 4.21. R1 = 500KQ, R2 = 500KQ, R2 = 1000KQ, Rf = 1000KQ ile giris ve ¢ikis sinyalleri
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Sekil 4.23. Cikarma yiikselte¢ devresinin 3D modeli
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“ornr
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B
LR A

Sekil 4.24. Cikarma yiikselte¢ devresinin girig-¢ikis bagintisi

The differential amplifiers amplify the
difference between two voltages making
this type of operational amplifier circuit a
Subtractor unlike a summing amplifiel

which adds or sums together the input

voltages.

Sekil 4.25. Cikarma yiikseltecin agiklamasi
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e Integral Yiikseltec

Islemsel yiikseltegler, hem giriste hem de geri bildirim déngiisiinde sadece saf direngler
kullanilarak bir pozitif veya negatif geri besleme yiikselticinin bir parcasi olarak veya bir
toplayict veya ¢ikarici tipi devre olarak kullanilabilirler. Eviren bir yiikselticinin geribesleme
elemant yerine kondansator baglanirsa, integral yiikselte¢ devresi olusmaktadir (Sekil 4.26).
Adindan da anlasilacagi gibi integral yiikselteg, entegrasyonun matematiksel islemini
gerceklestiren islemsel bir yiikselte¢ devresidir. Op-amp'li entegrator, giris geriliminin
integraliyle orantili bir ¢ikis gerilimi tiretmektedir (Tutorialspoint 2020).

Vin R

5> Vout

Sekil 4.26. Integral yiikseltecin devre semasi

Bir kondansatoriin plakalarindaki gerilim, kondansator tizerindeki yiikiin sigasina.

Ve = % Ve =Vx —Vout =0 —Vout (4.24)

dVout dQ 1dQ

— T _ X (4.25)
dt Cdt C dt
Vin—0 Vin
lin = = 4.26
"= TRin _ Rin (4.26)
dVout d d dVout.C
o = _c 40 _de_ dvout.C (4.27)

dt cdt  dt  dt

Op-amp'in giris empedansinin sonsuz oldugunu varsayildigindan (ideal op-amp), op-amp
terminaline hicbir akim akmamaktadir. Bu nedenle, eviren giris terminalindeki diigiim
denkleminden
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Vin _ dVout.C

lin=1f = 4.28
n=If = 2o dt (4.28)

Vin dt
= 4.29
Vout * RinC 1 ( )

1 t

t= — in dt 4.30
Vou RinCJO Vind ( )

sonucuna ulasilir. Integral yiikseltecin kullanim alanlart:

e Op-amp Integral yiikseltecler, analog bilgisayarlarda hesaplama islemlerini
gerceklestirmek i¢in kullanilir (Wikipedia 2020).
e integral devreler en yaygm olarak analogdan dijitale doniistiiriiciiler, rampa

jeneratorlerinde ve ayrica dalga sekillendirme uygulamalarinda kullanilir (Wikipedia
2020).

Buna gore farkli direng degerleriyle integral yiikselteg uygulamalart sirasiyla Sekil 4.27-4.28'te
verilmektedir. 3D, Vout ve Konu anlatimi butonlarina tiklanildiginda olusan goriintiiler de
sirasiyla Sekil 4.29-4.31'de goriilmektedir.
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Sekil 4.28. R = 50MQ, C = 10pF ile giris ve ¢ikis sinyalleri
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Sekil 4.29. integral yiikselte¢ devresinin 3D modeli

'.L“.n Wl 0 A . LR EEEE ‘ —
s ssws. TERR . » W% e m s e e

Sekil 4.30. integral yiikselte¢ devresinin giris-c1kis bagintis
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Sekil 4.31. Integral yiikseltecin agiklamasi

e Tiirev Yiikselteg

Islemsel kuvvetlendiricili tiirev devresi, uygulanan giris gerilimin degisim hiziyla orantil cikis
gerilimi {ireten bir konfigiirasyonudur. Yalnizca RC elemanlar igeren tiirev yiikselteglere pasif,
transistorler gibi aktif devre bilesenlerine sahip olanlar da aktif tiirev yiikseltegler olarak
adlandirilmaktadir (Tutorialspoint 2020). Sekil 4.32'de tiirev devresi verilmektedir.

L C
... S l l
Vin .
Ve I~Vout

ak
A

Sekil 4.32. Tiirev yiikseltecin devre semast
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Tiirev yiikseltecin kullanim alanlart:

lin=1If
I = Vout
Q=Cx*Vin
aQ CdVin
dt  ~ dt
lin — CdVin_I
in = P
Vout _c dVvin
Rf 4t
dVin
Vout = —Rf.C

dt

(4.31)

(4.32)

(4.33)

(4.34)

(4.35)

(4.36)

(4.37)

Tirev yiikseltegler, genellikle ti¢gen ve dikdortgen sinyallerle caligmak {izere
tasarlanmigtir (Wikipedia 2020).
Tiirev ylikseltecler, giris sinyalindeki yiiksek frekansl bilesenleri tespit etmek i¢in dalga
sekillendirme devreleri olarak da uygulama alan1 bulmaktadirlar (Wikipedia 2020).

Buna gore farkli diren¢ degerleriyle tiirev yiikselte¢ uygulamalari sirasiyla Sekil 4.33-4.34'te
verilmektedir. 3D, Vout ve Konu anlatimi butonlarma tiklanildiginda olusan goriintiiler de
sirastyla Sekil 4.35-4.37'de goriilmektedir.
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Sekil 4.34. C = 1puF, R =20MQ ile giris ve ¢ikis sinyalleri
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Sekil 4.35. Tiirev yiikselteg¢ devresinin 3D modeli
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Sekil 4.36. Tiirev yiikselteg¢ devresinin giris-¢ikis bagintisi
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[ his operational amplifier circuit performs the

mathematical operation of Differentiation, that '
IS It "proauces a voltage output which is directly ‘
proportional to the input voltage's rate-of-

change with respect to ume". In other words It j l
produces an output signal which i1s the first ‘
aerivative of the input signal. p—

..... R - e "Q.O‘

Sekil 4.37. Tiirev yiikseltecin agiklamasi
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5. SONUC

Gergeklik teknolojisindeki gelismeler, hayatin birgok alaninda biiyiik katkilar ve kolayliklar
saglanarak uygulanmaktadir. Bunlardan birisi de egitim alanidir. Ogrencilerin teorik bilgileri,
zengin multimedya destekleriyle gorsellestirebilmeleri siiphesiz daha iyi anlamalarmi ve
kavramalarini saglamaktadir. Ayrica bir¢ok karmasik, soyut veya ulasilmasi zor bilgilerin gorsel
olarak canlandirilabilmesi, bunlarin fiziksel karsiliklarinin hemen Onlerinde oldugu hissi
uyandirilmast hem 6grenme hem de anlayip kavrama motivasyonlarini arttirmaktadir.

Gergeklestirilen tez calismasinda elektrik-elektronik miihendisligi alaninda yogun bir sekilde
kullanilan temel islemsel yiikselte¢ devreleriyle ilgili AG platformu tasarlanmistir. Laboratuvar
imkanlarmin az, 6grenci sayilariin fazla veya Ogretim elemanlarmin kisitli oldugu yerlerde
ogrencilere yardimci olmasit hedeflenen uygulamada bir breadboard iizerine monte edilmis
isaretleyiciden (eviren, evirmeyen, toplama, fark, tiirev ve integral) olusmaktadir. Akilli telefon
ile isaretgi algilanarak ilgili devreye ait giris-¢ikis bagintisi, devrenin 3B yerlesimi/kurulumu ve
secilen devre elemanlarina gore girig-¢ikis isaretleri goriilmektedir. Boylece ilgili devre, fiziksel
olarak gerceklenmeden de tiim yonleriyle kullanicinin/6grencinin karsisina gelmektedir.
Istenildiginde AG platformunun sundugu devre yerlesimine bakilarak, Ogrencilerin ilgili
laboratuvar  deneylerini  (devre kurumlarini) gerceklestirmeleri de biiyiikk oranda
kolaylasmaktadir. Diger yandan, gelistirilen sistem 6grencilere sadece kolayca kullanabilmeleri
icin degil, ayn1 zamanda kavram teorisini daha iyi anlamalarin1 saglayacak sekilde yardimci
olmaktadir.

Uygulamanin Android OS isletim sistemli akillt telefondak.i testinde, isaret¢inin (devrenin) hizhi
bir sekilde algilandigi ve diizgiin c¢alistig1 gosterilmistir. Isaret¢inin taninma kalitesi etkileyen
faktorler aydinlatma ve kameranin 6zellikleri olarak ortaya ¢ikmaktadir.

Gelecek calismalarda da cazip bir Ogrenme/6gretme ortami olusturan AG teknolojileri
kullanilarak, baska dersler/konular i¢in de - farkli 6zellik ve yapilarda - bu tip platformlarin
tasarlanmasi hedeflenmektedir.
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